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Adobe Acrobat 8 PDF Bible is written for a cross-platform audience. Users of Microsoft Windows
2000 with Service Pack 2, Windows XP Professional or Home Edition, Tablet PC Edition, and
Apple Macintosh computers running OS X v10.2.8, 10.3, and later will find references to these

operating systems.

About This Book
Most of the chapters in this book include screenshots from Acrobat running under Windows. The user
interface is closely matched between Windows and the Macintosh; therefore, Macintosh users will find
the same options in dialog boxes and menu commands as found in the screenshots taken on a Windows
machine. Where significant differences do occur, you’ll find additional screenshots taken on a Macintosh
to distinguish the differences.

How to read this book
I have to admit this publication is not a page turner that leaves you grasping for more time to finish up a
chapter before retiring at night. After all, it’s a computer book and inasmuch as my editors at Wiley
always strive to get me to add a little drama to the text, few people will pick up this Bible and read it
cover to cover. This book should be thought of more as a reference where you can jump to an area and
read over the contents to help simplify your work sessions in Acrobat Standard (now available only on
Windows in version 8.0) or Acrobat Professional version 8.0.

Because Acrobat is such a behemoth program and can do so many things for almost any kind of work
activity, most people won’t use every feature the program provides. You may be interested in converting
files to PDF and setting up reviews, or you may devote more attention to the area of prepress and print-
ing, or perhaps it’s accessibility or PDF forms that’s part of your work. Therefore, you may ignore some
chapters and just want to jump to the area that interests you most.

Regardless of where you are in Acrobat experience, you should be able to gain much insight and skill at
using the new version of Acrobat by studying in detail those areas that interest you most. However, don’t
completely ignore chapters that cover features you think you won’t use. You can find many related con-
cepts falling under headings that are not exclusively related to the general topic for each chapter. For
example, you may not be interested in creating accessible PDFs for screen readers. However, the
Accessibility chapter also includes coverage of document structures and tagging, which will be impor-
tant if you need to get the content of a PDF back out to an authoring application.

Because many chapters may include features that relate to the work you want to perform, studying over
the most important features of interest to you and skimming over those chapters that appear to be less
beneficial for you works best.
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To begin, I recommend you look closely at the section in the Introduction covering new features in Acrobat
8.0. No matter where you are in Acrobat skill, be certain to understand PDF navigation, as things have
changed for moving around PDF files and creating cross-document links. Look closely at the Help docu-
ments and the Help features in Acrobat 8.0. Pay particular attention to Chapters 8, 12, 14, 19, 29, and 31.
If you’ve read the Adobe Acrobat 7 PDF Bible, these chapters are all new in this revision of the book. In many
other chapters of the book, the text has been completely updated and revised. Some chapters have been
expanded to cover more depth in specific areas. For example, Chapter 33 on Adobe LiveCycle Designer has
been expanded by more than 50 pages over the last book.

Throughout the book are sections called “Steps.” If you find the contents of a given series of steps interest-
ing, follow the steps to see whether you can replicate what is covered in that section. In this book, I’ve
made an effort to expand steps greatly to provide you some tutorial assistance in understanding many 
concepts.

Icons
The use of icons throughout the book offers you an at-a-glance hint of what content is being addressed. You
can jump to this text to get extra information, be warned of a potential problem, or amplify the concept
being addressed in the text. In this book you’ll find icons for the following:

A Caution icon alerts you to a potential problem in using Acrobat, any tools or menus, or any
supporting application that may be the origination of a document to be converted to PDF. Pay

close attention to these caution messages to avoid potential problems.

The Cross-Ref icon indicates a cross-reference to another area in the book where more infor-
mation can be found on a topic. It is almost impossible to walk you through Acrobat in a linear

fashion because it has so many interrelated features. Covering all aspects of a single feature in a contiguous
section of the book just doesn’t work. Therefore some common features for a command, a tool, an action, or
task may be spread out and discussed in different chapters. When the information is divided between differ-
ent sections of the book, you’ll find a Cross-Reference icon that cross-references the current passage to
another part of the book covering related information.

An icon appears throughout the book where a new feature in Acrobat 8 has been added to the
program. Pay special attention to these icons to learn more about what has been added to

Acrobat 8, Adobe Reader 8, and Adobe LiveCycle Designer 8.

A Note icon signifies a message that may add more clarity to a text passage or help you deal
with a feature more effectively.

Where workflow solutions are particularly applicable, you’ll see an icon indicating that the
text describes tasks or features that apply to workgroups and workflows. This icon will be an

important signal for people in large businesses, government, and education where large workgroups with
common tasks exist.

Much support is offered in version 8.0 for the prepress and printing market. If you’re a design
professional, service bureau, or print shop, take note of these messages for information related

to prepress and printing.

Tips are handy shortcuts. They help you to more quickly produce results or work through a
series of steps to complete a task. Some tips provide you with information that may not be

documented in the Help files accompanying Acrobat Professional.
TIPTIP

PREPRESSPREPRESS

PDF WORKFLOWPDF WORKFLOW

NOTENOTE

NEW FEATURENEW FEATURE

CROSS-REFCROSS-REF

CAUTION CAUTION
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The book’s contents
This book is about Adobe Acrobat Standard (on Windows) and Adobe Acrobat Professional on Windows
and the Macintosh. All the content in the book applies to Acrobat Standard, unless you see a reference that
a specific section applies only to Acrobat Professional. Acrobat Professional features are clearly marked
throughout the book so you know when Acrobat Standard doesn’t support a particular feature.

Just about everything that you can do with Adobe Acrobat is contained in the chapters ahead. This book is
not about Adobe LiveCycle Designer, Acrobat PDF Forms, collaboration, PDF creation, Acrobat JavaScript,
or some other aspect of Acrobat exclusively. Some Acrobat features can take a book this size alone to cover
in their entirety. What this book does for you is provide you some exposure and understanding for all that
Acrobat can do. You’ll find chapters on Adobe LiveCycle Designer and Acrobat JavaScript, several chapters
on PDF creation, and chapters on collaboration. However, any one of these areas is not exclusive to the con-
tent of the book.

I’ve made an effort to address many different uses for all types of users. This book covers Acrobat features
and how to work with Adobe Acrobat Professional, Adobe Acrobat Standard, Adobe Reader, and compan-
ion products. Individual industries such as office occupations, digital prepress, engineering, enterprise
workflows, and multimedia and Web publishing are covered. Regardless of what you do, you should be
able to find some solutions for your particular kind of work. Whether you are an accounting clerk, a real
estate salesperson, a digital prepress technician, an engineer, a Web designer, or a hobbyist who likes to
archive information from Web sites, there’s a reference to your needs and Acrobat will provide a solution.

To simplify your journey through the new release, the book is broken up into six separate parts. A total of
36 chapters address Acrobat features and some individual purposes for using the software. The six parts
include the following:

Part I: Welcome to Adobe Acrobat. To start off, I offer some discussion on the PDF format and its new
revision. Acrobat 8.0 has many new features and a new Getting Started window to help you find help fast. I
cover tools, menus, and palettes to help you understand many Acrobat 8.0 features. This section covers the
distinctions between different viewer types, navigating through PDFs, and using the Find tool and the
Search panel to search PDF files.

Part II: Converting Documents to PDF. There are many different ways to create a PDF document and all
these methods are thoroughly covered in Part II. I begin by discussing the ease of creating simple PDF files
that might be used by office workers and travel through to much more sophisticated PDF file creation for
more demanding environments. A new chapter devoted entirely to Microsoft applications has been added.
In addition, I discuss how many application software manufacturers are supporting PDFs through direct
exports from their programs. I discuss the Adobe Creative Suite and how you can integrate PDF with the CS
applications. A bonus chapter on the CD-ROM in the CD version of the book has been added to detail more
of what you can do with Acrobat Distiller for creating PDF documents. The advantages and disadvantages of
using all these methods are also discussed.

Part III: Editing PDFs. This section covers editing, modifying, and enhancing PDF files for many different
purposes. Also covered are how to modify content and how to flow content between Acrobat and authoring
programs. New features for combining and packaging PDFs and redacting PDFs are added in special new
chapters. I also discuss scanning in Acrobat and converting scans to text with Optical Character Recognition
(OCR). Document repurposing is covered in this section for users who want to modify files for different
output mediums. Another new chapter on all the enabling features available in Acrobat Professional is
included in this section.
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Part IV: PDF Interactivity. Part IV covers interactivity with PDF documents for workgroups through the
use of Review and Comment tools, shared reviews, adding interactive elements such as multimedia, and
links and buttons. I address the layer features in Acrobat Professional and include a chapter devoted to
making PDF documents accessible.

Part V: PDF Publishing. This section covers distribution of PDF files in some of the more common means
available today. I begin with security and authentication as your first step in document distribution and then
move on to PDF workflows. I discuss creating PDFs for different kinds of distribution, such as presenta-
tions, and offer complete coverage of all the printing and prepress features. I also offer information about
eBooks in Part V. Hosting your PDFs on the Web and sending them via e-mail are also covered in this sec-
tion. New chapters have been added in this section that cover the new Acrobat Connect application and a
chapter is devoted to printing color PDFs to desktop color printers.

Part VI: Acrobat PDF and LiveCycle Designer Forms. This section covers PDF forms and data. For
Windows users I cover using Adobe LiveCycle Designer 8 in a much more extended and detailed chapter
for forms authoring. All the new forms features for distributing forms, collecting form data, and running
form field recognition are included in this section. An introduction to JavaScript and writing simple
JavaScript routines is also included in this section.

Staying Connected
It seems like new products and new upgrades are distributed about every five minutes. If you purchase a
software product, you can often find an updated revision soon after. Manufacturers rely more and more on
Internet distribution and less on postal delivery. You should plan on making routine visits to Adobe’s Web
site and the Web sites of third-party product manufacturers. Any software vendor that has a Web site will
offer a product revision for download or offer you details on acquiring the update.

Internet connection
With newer releases of computer software, an Internet connection is now essential. Programs, including
Acrobat, prompt you routinely to check for updates over the Internet. To optimize your performance with
Acrobat, you should run the software on a computer that has an Internet connection.

Registration
Regardless of whether you purchase Acrobat Professional, Acrobat Standard, Acrobat 3D, or Acrobat
Elements, or download the free Adobe Reader software, Adobe Systems has made it possible to register the
product. You can register on the World Wide Web or mail a registration form to Adobe. If you develop PDF
documents for distribution, Adobe likes to keep track of this information. You will find great advantage in
being a registered user. First, update information will be sent to you, so you’ll know when a product revi-
sion occurs. Second, information can be distributed to help you achieve the most out of using Acrobat.
Who knows — some day you may be asked to provide samples of your work that might get you a hit from
Adobe’s Web site. By all means, complete the registration. It will be to your benefit.

Web sites to contact
Obviously, the first Web site to frequent is Adobe’s Web site. When Acrobat and the Acrobat plug-ins are
revised, downloads for updates will become available. You can also find tips, information, and problem
solutions. Visit Adobe’s Web site at www.adobe.com. Also make use of the Help➪Adobe Expert Support
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menu command in all Acrobat viewers. This command opens a Web page where you can order technical
support for a nominal fee. For acquiring plug-ins for Acrobat visit the Adobe Store where you can find a
comprehensive list of plug-ins and demonstration software that works with Acrobat. Visit the Adobe Store
at: www.store.adobe.com/store.

A wealth of information is available on the Acrobat Users Community Web site at www.acrobatusers.com.
Here you can find tips, techniques, blogs hosted by some of the world’s leading Acrobat professionals, and sup-
port for starting and maintaining a local Acrobat User Group. Be certain to routinely check Acrobat Users for
up-to-date information and assistance. You can e-mail leading professionals who can help you solve problems.

Acrobat tips are available on many Web sites — all you need to do is search the Internet for Acrobat infor-
mation. An excellent source for information as well as a comprehensive collection of third-party plug-ins is
Planet PDF. You can visit them at www.planetpdf.com.

More Acrobat plug-ins can be found on ThePowerXChange Web site. Log on to www.thepower
exchange.com Web site for a vast list of Acrobat plug-ins and demo software.

Another source of information, articles, tips, Acrobat and PDF information can be found at www.pdfZone
.com. Visit the pdfZone Web site for up-to-date articles and interviews with industry leaders.

If learning more about Acrobat is your interest, you can find regional conferences sponsored by DigiPub
Solutions Corporation. If you want to meet and discuss PDF issues with some of the world’s experts, look
for a conference in your area. You can find information at www.pdfconference.com.

The American Graphics Institute offers another PDF conference program. You can find out more informa-
tion by logging on to www.AGItraining.com.

A new conference has popped up in the Midwestern part of the USA in Council Bluffs, Iowa. To find out
more about the Acrobat Central Conference log on to www.pdfcentralconference.com.

The Open Publish conference in Sydney, Australia, is an annual conference for design and creative profes-
sionals. This organization hosts many PDF-related seminars and workshops annually. Find out more at
www.openpublish.com.au.

In Japan try out the PDF Conference held in Tokyo. Visit www.pdfconf.gr.jp for more information.

Whatever you may desire is usually found on some Web site. New sites are developed continually so be cer-
tain to make frequent searches. 

Contacting Me
If, after reviewing this publication, you feel some important information was overlooked or you have any
questions concerning Acrobat, you can contact me and let me know your views, opinions, hoorahs, or com-
plaints, or provide information that might get included in the next revision. (If it’s good enough, you might
even get a credit line in the acknowledgments!) By all means, send me a note. Send your e-mail inquiries to
ted@west.net.

Chances are that if you have a problem or question about Acrobat, you’re not alone and many others might
be interested in your question and a response to the question. Send your questions directly to my blog on
Acrobat Users at: www.acrobatusers.com/blogs/tedpadova. In addition to my blog, some very 
talented friends who know so much more than I do also host blogs on Acrobat Users. Visit www.acrobat
users.com/blogs to see a complete list of the blog hosts.
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If you happen to have some problems with Acrobat, keep in mind that I didn’t engineer the program.
Inquiries for technical support should be directed to the software developer(s) of any products you use.
This is one more good reason to complete your registration form.

There you have it — a short description of what follows. Don’t wait. Turn the page and learn how Acrobat
can help you gain more productivity with its amazing new features.
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This book is the fifth edition of Acrobat PDF Bible. As a result of feedback from many users, this
edition is an effort to include coverage of some topics missed in the last version and to add addi-
tional material where users asked for more detail. As you will see by browsing the contents of the

book or launching the new version of all the Acrobat viewers, including Adobe Reader, Adobe Acrobat
Standard (Windows only), and Adobe Acrobat Professional, there are many changes in the programs. As
such, I’ve made an effort to cover as much of the new version as is possible in this single, comprehensive
book.

What Is Adobe Acrobat?
We’ve come a long way in Acrobat evolution, and those users of Adobe Acrobat are familiar with the dis-
tinctions between the Adobe Reader software and Adobe Acrobat (either Standard or Professional).
However, among the many users of Adobe Reader, there still exists some confusion about what Reader
can and cannot do. When acquiring Adobe Reader, many folks think the viewing of PDF documents
with Adobe Reader is the extent of Acrobat. Now in version 8, Adobe Reader can do much more in
terms of editing PDF documents. In addition to editing features, Acrobat Professional 8.0 now includes
the much desired options for enabling PDFs with special features for Adobe Reader users for saving form
data and adding digital signatures.

For those who don’t know the difference, I explain in Chapter 2 that Adobe Reader is only one small
component of Acrobat. Other programs included in the suite of Acrobat software provide you with tools
for creating, editing, viewing, navigating, and searching Portable Document Format (PDF) information.
Regardless of your familiarity with previous versions of Acrobat, you should carefully review Chapter 2.
In Chapter 4, you’ll find some details on all the new features added to Adobe Reader and how you can
add to PDF documents some new Reader Extensions that enable the Adobe Reader user much more
functionality than was available in all versions prior to version 8.

Acrobat has evolved with many different changes both to the features it offers you and often to the
names associated with the various components. In earlier versions of Acrobat, names such as Acrobat
Professional, Acrobat Exchange, and then simply Acrobat were used to refer to the authoring applica-
tion. Version 8.0 of Adobe Acrobat, fortunately, continues with the same product names as found in
Acrobat 7. The high-end performance application is referred to as Adobe Acrobat Professional. In 
release 8, as was the case in version 7, there is also a lighter Acrobat version with many of the same fea-
tures found in Acrobat 5.x. The lighter version, also the same as was available in Acrobat 7, is called
Adobe Acrobat Standard. Now in version 8 of Acrobat, Acrobat Standard has been discontinued on the
Mac and appears only on Windows. This program has all the features you find available in Acrobat
Professional with the exception of forms authoring, high-end printing and prepress, enabling documents
with Adobe Reader extensions, and some differences in tools and menu commands. As you follow the
pages in this book, you can apply most of what is contained herein to either Acrobat Standard or
Acrobat Professional, with the exception of Chapters 19 and 32, and Part VI where I talk about forms.
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One more product you can purchase from Adobe Systems in the Acrobat family is Adobe Acrobat Elements.
Elements is a low-cost PDF-creation tool designed for enterprises, and it requires that you purchase a site
license of a minimum of 1,000 copies. The Adobe Acrobat Reader software remains a free download from
Adobe Systems and offers you many more features than found with previous versions of the Acrobat Reader
software.

Nomenclature
The official name for the new release of the high-end Acrobat product is Adobe(r) Acrobat(r) 8.0
Professional. You’ll notice the registered marks appearing in the name. For the sake of ease and clarity, as
you read through the book and see a reference to Acrobat, Adobe Acrobat, and Acrobat Professional (also
called Acrobat Pro), please realize that the reference is to Adobe Acrobat Professional. For the other author-
ing application, the official name is Adobe(r) Acrobat(r) Standard. When referring to this product I may use
terms such as Acrobat Standard or simply Standard. Where it makes sense I’ll say it like it is supposed to be
used; otherwise, I’ll use an abbreviated name.

The official name for the lighter version is Adobe Acrobat Elements, and the free downloadable software is
Adobe Reader. Again, for the purposes of communication and ease, I may refer to the applications as
Elements or Reader. Please realize, however, that the official name should prevail when you communicate in
writing about these products.

For Windows users, Acrobat 8.0 Professional also ships with Adobe(r) LiveCycle(r) Designer 8.0. You may
find references to this product stated as LiveCycle Designer, Designer, or LCD. All of these references are
made to the Adobe LiveCycle Designer product used for authoring dynamic XML-based forms.

Why is this important? Adobe Systems, Inc., has spent much time, labor, and money on developing brand-
ing for their products. With the different changes to product names and the different components of the
software, some people using the products don’t completely understand the differences or where the product
came from. An Adobe Reader installer can appear on CD-ROMs distributed legitimately by users, and some
end users may not know that it is a product available for upgrading at the Adobe Systems, Inc., Web site.
Therefore, using the formal name can help users understand a little bit more about the software.

And there’s a very good reason for helping Adobe Systems with the recognition and marketing of its prod-
ucts. If the product doesn’t do well in the marketplace, you might one day see it disappear. You won’t want
that to happen because when you start working with the new release, you’ll easily see many great new fea-
tures and much more polish added to the programs. Adobe Systems has done well in bringing the entire
Acrobat family of products to maturity and I’m certain you’ll find many more new uses for Acrobat.

Above all, realize that Adobe is not a product. Adobe or Adobe Systems is a company. Making a reference to
Adobe when you mean Acrobat or Adobe Reader is improper and promotes confusion. When referring to
the products, be certain to include Acrobat, Standard, or Reader.

Adobe Systems and the Acrobat mission
Adobe Systems, Inc. began as a company serving the graphic design and imaging markets. With the release
of PostScript, its first product, much development in the early years of its history was devoted to imaging
programs, font libraries, and tools to help service graphic design professionals. When you speak to graphic
designers and advertising people, they connect Adobe Systems with products such as Adobe Photoshop,
Adobe Illustrator, Adobe InDesign, Adobe Premiere, and so on. With some of these flagship programs hav-
ing long histories and large installed user bases, some people may think that a product such as Adobe
Acrobat takes a back seat to the high-end graphics and multimedia programs.
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Where does Acrobat fit into Adobe’s mission and view of its product line? Adobe Chairman and CEO Bruce
Chizen has been quoted as saying that he expects the Acrobat family of products to weather economic
storms in the software market. Acrobat is Adobe’s fastest-growing product, experiencing between 40 to 60
percent growth in year-over-year sales. Chizen has also stated that more than 60 percent of Adobe’s world-
wide sales and marketing personnel are devoted to Acrobat-related products from the Acrobat 5 life cycle to
the present.

Adobe sees Acrobat as an integral part of its future and is investing much energy into Acrobat’s growth.
With more than 750,000,000 installed users of the Adobe Reader software, Acrobat and the PDF file format
are among the most popular software products available today.

Acrobat has become a standard in many different industries. In the publishing market many large news-
paper chains, publishing houses, and book and magazine publishers have standardized on the PDF format
for printing and prepress. The prepress industry has long adopted PDF as a standard for commercial and
quick-print houses. Almost every software manufacturer includes last-minute notes, user manuals, and sup-
porting information in PDF format on CD-ROM installer disks. The U.S. federal, state, and city govern-
ments and the U.S. government contractor organizations have standardized on PDF for everything from
forms, applications, notices, and official documents to intra-office document exchanges.

With the introduction of the Acrobat 6 product line, Adobe Systems expanded existing markets and tar-
geted new markets. The features in Acrobat 6 and 7 Professional appealed to all kinds of engineering profes-
sionals. With the support for layers and direct exports from programs such as Microsoft Visio and Autodesk
AutoCAD, engineers, planners, and architects welcomed the new additions to Acrobat. Now in Acrobat 8,
users of Acrobat Professional can convert AutoCAD .dwg drawings to PDF complete with layers and com-
ments without having AutoCAD installed on a computer. Enterprises, in which document flows include dif-
ferent workgroups for almost any industry, welcomed additions to the comment and review tools in Acrobat
Professional. Additional enabling usage rights for Adobe Reader users in Acrobat 8 are another great feature
for knowledge workers. The already standardized prepress market applauded new features for printing to
high-end imaging devices without the use of third-party plug-ins. Seamless integration of JDF job ticketing
with Acrobat and Creative Suite is now available in Acrobat 8 and the CS applications 2.3 and greater for
the creative pro market. All the great new features in Acrobat 6 and 7 have now been amplified in version 8,
and you find additional support for users in almost every industry. New Redaction tools and Bates
Numbering will be welcomed additions for the legal community. Also, concurrent to Acrobat development,
the Acrobat 3D product is continuing to be expanded with new features to suit the manufacturing industry.
The list keeps growing and Acrobat keeps improving.

PDF workflows
A workflow can mean different things to different people. One of the nice aspects of working with Acrobat
is the development of a workflow environment. Quite simply, workflow solutions are intended to get out of
a computer what the computer was designed for: productivity in a more automated and efficient fashion.
Editing page by page and running manual tasks to change or modify documents could hardly be called
workflow solutions. Workflows enable office or production workers a means of automating common tasks
for maximum efficiency. Batch processing documents, running them through automated steps, and routing
files through computer-assisted delivery systems are among workflow solutions.

Acrobat provides workflow solutions in almost every industry and new features added to Acrobat 8 add
some polish to an already great product. But the real advance in workflow activity is the introduction of
Acrobat Connect. Now, instead of having documents flow across wide area networks, people can connect
through real-time online events. The introduction of Acrobat Connect will not only ease a tremendous
financial burden saving companies huge expenses for employee travel, but increase productivity in work-
flows through dynamic interaction.
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New Features in Adobe Acrobat Professional
The changes to Acrobat in version 8.0 represent many more expanded and new features to an already
impressive product. Just about everything you could do in the last version is still available in version 8.0,
but there have been many additions to existing features and some new options for a variety of Acrobat uses.
The user interface has greatly changed over all previous versions of Acrobat, adding more tools and com-
mands and features and much easier methods for accessing tools. 

In each chapter I’ve added a special icon to point out new features. Some new chapters have been added to
this version that deal exclusively or mostly with new features. Chapters 3, 12, 14, 19, and 29 cover new fea-
tures in much detail. The remaining chapters all cover some new features added to Acrobat and respective
to the chapter topic.
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To start off this large book on Adobe Acrobat, let’s first take a look at what
Acrobat is and what PDF is, and let’s try to get a grasp on some of the
many options you have for working with PDF files in Acrobat. 

What Is Adobe Acrobat?
Assuming you know little about Adobe Acrobat, I start with a brief description of
what Acrobat is and what it is not. As I explain to people who ask about the
product, I usually define it as the most misunderstood application available
today. Most of us are familiar with the Adobe Reader software, which is a product
from Adobe Systems Incorporated that you can download free from the Adobe
Web site (www.adobe.com/acrobat/readermain.html). You can also
acquire the Adobe Reader from all the installation CD-ROMs for other Adobe
software. You can even acquire Adobe Reader from other sources, as long as the
Adobe licensing requirements are distributed with the installer program. The
Adobe Reader, however, is not Adobe Acrobat. Adobe Reader is a component of a
much larger product family that has evolved through several iterations over more
than a decade.

You’re probably a little more sophisticated and realize there is a major difference
between the applications noted previously and you may wonder why I even
spend any time discussing the difference between Acrobat and Adobe Reader.
Unfortunately, many people still believe that Adobe Acrobat is the free Adobe
Reader program.

To add a little more confusion, Adobe continues to market several Acrobat prod-
ucts in the Acrobat family. While Adobe Reader remains a free download from
Adobe Systems, there are three additional commercial viewers — Acrobat
Standard, Acrobat Professional, and Acrobat 3D. With the release of Acrobat 8,
Acrobat Standard is now offered only to Windows users, and has been dropped
from the Macintosh version. As I talk about Adobe Acrobat in this chapter, and
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throughout the book, I’m referring to Acrobat Professional for both Windows and Macintosh and Acrobat
Standard for Windows users only. Where the two programs differ in features, I point them out. I also men-
tion when a feature is only available in Acrobat Professional. 

There are distinctions between the Acrobat Standard product (Windows) and the Acrobat
Professional product in terms of tools and commands. Most editing tasks can be handled in

either viewer; however, Acrobat Professional does provide more editing features than Acrobat Standard.
Throughout this book I delineate the differences and point out when an Acrobat Professional feature cannot
be accomplished in Acrobat Standard.

Adobe Acrobat (either Standard or Professional) in version 8 is the upgrade from Adobe Acrobat 7
(Standard or Professional) and both viewers are the subject of the remaining chapters of this book. Acrobat
is the authoring application that provides you tools and commands for a host of features outlined in the fol-
lowing chapters. If you haven’t yet purchased a copy of Acrobat, either the Standard version (Windows
only) or the Professional version (Windows and Macintosh), you might want to look over Chapter 2 and
observe some of the comparisons between the viewers. If fewer tools and features suit your purpose, you
might find the Standard version satisfactory — but remember, Acrobat Standard is available only on
Windows in version 8. Although some of the features differ between the viewers, they both provide many
features for editing, enhancing, printing, and working with PDF documents.

Acrobat is an authoring application but it has one little feature that distinguishes it from almost any other
authoring program. Rather than starting from scratch and creating a new document in Acrobat, your work-
flow usually involves converting a document, created in just about any program, to a Portable Document
Format (PDF) file. Once converted to PDF you use Acrobat to edit and refine the document, add bells and
whistles and interactivity, or prepare it for professional printing. In addition to the Acrobat program,
Acrobat Professional ships with companion programs such as Adobe Acrobat Distiller and Adobe Acrobat
Catalog, and Adobe LiveCycle Designer (Windows only). Acrobat Standard ships only with Acrobat
Distiller. These companion products are used to convert PostScript files to PDF, create search indexes, and
author XML-based forms.

For information related to Acrobat Distiller see Chapter 10. For more information on Acrobat
Catalog, see Chapter 6. For more information related to LiveCycle Designer, see Chapter 35.

Acrobat solutions are greatly extended with other supporting programs from Adobe Systems and many dif-
ferent third-party vendors. If Acrobat can’t do the job, chances are you can find a plug-in or companion
program to handle all you want to do with a PDF file.

For information related to Acrobat plug-ins and companion products see Chapter 2.

What Is PDF?
PDF, short for Portable Document Format, was developed by Adobe Systems as a unique format to be viewed
through Acrobat viewers. As the name implies, it is portable, which means the file you create on one com-
puter can be viewed with an Acrobat viewer on other computers, handheld devices, and on other platforms.
For example, you can create a page layout on a Macintosh computer and convert it to a PDF file. After the
conversion, this PDF document can be viewed on a Linux or Windows machine.

Multiplatform compliance (to enable the exchange of files across different computers, for example) is one of
the great values of PDF documents.
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So what’s special about PDF and its multiplatform compliance? It’s not so much an issue of viewing a page
on one computer created from another computer that is impressive about PDF. After all, such popular pro-
grams as Microsoft Excel, Microsoft Word, Adobe Photoshop, Adobe InDesign, Adobe FrameMaker, and
Adobe Illustrator all have counterparts for multiplatform usage. You can create a layout on one computer
system and view the file on another system with the same software installed. For example, if you have
Adobe InDesign installed on a Macintosh computer and you create an InDesign document, that same file
can be viewed on a PC with InDesign running under Windows.

In a perfect world, you may think the capability to view documents across platforms is not so special.
Document viewing, however, is secondary to document integrity. The preservation of the contents of a page
is what makes the PDF so extraordinary. To illustrate, suppose you have an InDesign document created in
Windows using fonts generic to Windows applications. After it’s converted to PDF, the document, complete
with graphics and fonts intact, can be displayed and printed on other computer platforms. And the other
computer platforms don’t need the fonts, graphics, or original authoring application to print the file with
complete integrity.

This level of document integrity can come in handy in business environments, where software purchases
often reach quantum costs. PDF documents eliminate the need to install all applications used within a par-
ticular company on all the computers in that company. For example, art department employees can use a
layout application to create display ads and then convert them to PDF so that other departments can use the
free Adobe Reader software to view and print those ads for approval.

The benefits of PDF viewing were initially recognized by workgroups in local office environments for elec-
tronic paper exchanges. Today users have much more opportunity for global exchange of documents in
many different ways. As you look at Acrobat and discover some of the features available for document com-
ment and markup, comparing documents, support for layered files (which adds much more functionality to
Adobe Reader), and preparing PDFs for screen readers, you’ll see how Acrobat and the PDF have evolved
with new technologies.

The term “screen reader” is used extensively throughout this book. When you see a reference
to “screen reader,” I’m referring to either a hardware device or special software (JAWS,

Kurzweil, and so on) used to convert visual information to audio format. For more information on screen
readers and making documents accessible to the readers, see Chapter 25.

Document repurposing
The computer revolution has left extraordinary volumes of data that were originally designed to be printed
on paper on computer systems. Going all the way back to UNIVAC, the number crunching was handled by
the computer and the expression was the printed piece. Today, forms of expression have evolved to many
different media. No longer do people want to confine themselves to printed material. Now, in addition to
publishing information on paper, we use CD-ROMs, the Internet, file exchanges, and meeting sessions via
the Internet between computers. Sometimes we use motion video, television, and satellite broadcasts. As
high-speed access evolves, we’ll see much larger bandwidths, so real-time communication will eventually
become commonplace.

Technology will advance, bringing many improvements to bandwidth, performance, and speed. To enable
the public to access the mountains of digital data held on computer systems in a true information super-
highway world, files need to be converted to a common format. A common file format would also enable
new documents to be more easily repurposed, to exploit the many forms of communication that we use
today and expect to use tomorrow.
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Acrobat Professional has added more tools for helping users repurpose documents. Tools for repairing prob-
lem files, downsizing file sizes, porting files to a range of different devices, and eliminating unnecessary data
are part of the many features found in Acrobat Professional. In addition, the new PDF/A format available in
Acrobat 8 is designed specifically for archiving documents. A standards committee has developed this for-
mat so documents viewed on computer systems 100 years from now will be compatible with future operat-
ing systems.

PDF and Adobe PostScript
The de facto standard for nearly all printing in the graphics industry has been Adobe PostScript. While
PostScript is still the dominant printing language, this will slowly change because Adobe has recently
announced support for PDF as the new print standard.

Okay, so how does PostScript relate to PDF? In the initial release of Acrobat, all PDF conversion began with
a file that was created as a PostScript file. Users selected the Print command in an authoring program and
printed the file to disk — thus creating a PostScript file. This file was then opened in the Acrobat Distiller
program and Distiller converted the PostScript to a PDF.

Distiller is still a part of Acrobat. In some cases, creating a PDF from a PostScript file rather than through
any of the many other means available may be preferable. It could be that you have a problem with export-
ing to PDF from a program, such as fonts not appearing embedded, or you may need to create a PDF for a
special purpose such as printing and prepress. In such circumstances using Acrobat Distiller may be your
best solution for generating a PDF document to properly suit the purpose.

For information related to printing PostScript files and using Acrobat Distiller see Chapter 10.

Printing to PostScript and opening PostScript files in Distiller is used much less today because now so many
programs support PDF creation through one-button clicks or using the Save As command. However, many
of these one-button clicks still use the Distiller application in the background to create the PDF file. You
may not see Distiller launched when PDFs are created in the background, but the program is working away
to convert your authoring application document to a PDF file. 

PostScript can be a problem solver for you, and you may have an occasional need to use it even if your
workflow does not require its use all the time. The more you know about PostScript and Acrobat Distiller,
the more often you might be able to rescue problem files that don’t seem to properly convert to PDF.

PDF versions
Acrobat is now in version 8. The version number indicates the number of releases of the product. PDF is a
file format and with it you’ll also find a version number. The PDF version relates to the specifications of the
file format; for the end user it’s usually not so important to understand all the specifications as much as it is
to know what it does for you or what you can expect from it. If you create PDF documents for users of
older Acrobat viewers and use the newer PDF format, your users may not be able to view your PDF files.
Conversely, creating PDF files with the older version might prohibit you from using some newer features in
the recent release.

PDF versions are typically referred to as Acrobat Compatibility. A PDF version 1.7 file, for example, is an
Acrobat 8 compatible file. To understand how the PDF version relates to the Acrobat version, simply add
the digits of the PDF version together. For example, PDF version 1.4 is Acrobat 5–compatible (1 + 4 = 5).
PDF version 1.5 is Acrobat 6–compatible, and so on.

CROSS-REFCROSS-REF
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Each PDF version provides support for additional features. It’s not as important to know all the features
enabled by one version as it is to know which PDF version you need to use. For example, to optimize a PDF
file for printing, you may need to use PDF version 1.3 (Acrobat 4–compatible). Or, if you want to embed
movie files in a PDF, then you need to use an Acrobat 6–compatible file (PDF version 1.5). Or, you may
want to add password security to a PDF that requires a newer Acrobat viewer to open a file using a pass-
word.

Rather than try to remember a long list of compatible features, you are generally informed when one PDF
version is needed over another as you work through editing PDFs in Acrobat. In addition, when you know
your user audience and the version of Adobe Reader or Acrobat that users have installed on computers,
you’ll know which Acrobat-compatible version of a PDF to create.

Understanding PDF Standards
PDF has been adopted as a standard file format in many industries, including engineering, legal, manufac-
turing, and prepress and printing. Even the United States Federal Government, has embraced PDF as a
standard file format.

So what are standards? Without regulation and approved standards, the computer industry would be
chaotic. Fortunately, an international committee known as the International Organization for
Standardization (ISO) develops and approves standards for the technical industry. This international com-
mittee, an entity apart from Adobe Systems, has approved and developed substandards of the PDF format.

The PDF standards available now include the following:

n PDF/X. This standard is a subset of the PDF format used in the printing industry. PDFs meeting
PDF/X compliance are typically reliable and, theoretically, can be accurately printed on almost any
kind of PostScript device.

n PDF/E. This standard is a subset of the PDF format designed for engineers to insure that indus-
trial designs and drawings comply with a PDF standard.

n PDF/A. This standard is a subset of the PDF format used for archiving documents. The standards
committee wants to insure that the files you create today and save as PDF can be viewed by com-
puters many years in the future. To do so, the PDFs you create for archival purposes can be saved
as PDF/A documents.

n PDF/UA. Although, as of this writing, this subset of the PDF format is in an early draft stage, you
may be hearing more about it in the near future — about one to two years from this writing. The
goal of this proposed new standard is to provide universal access (UA) to all users including those
persons working with assistive devices (see Chapter 25 for more on PDFs and assistive devices).
The proposed new format is in the hands of the AIIMS Standards Board Committee that also pro-
posed the PDF/X and PDF/A standards and submitted them to the ISO. People interested in par-
ticipating on the committee can find more information at www. aiim.org/standards
.asp?ID=27861.

Looking at the New User Interface
If you’re an Acrobat user, the first thing you’ll notice when you launch Adobe Acrobat 8 or Adobe Reader 8
is a new appearance for the user interface (UI). Many changes have been made to the Acrobat window, some
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of which you may like and others you may not. I’ll explain more about the user interface in later chapters
where I discuss tools and viewing PDF documents. For now, let me share the reasons why Adobe has made
the current significant changes to Acrobat 8.

Adobe Systems is a company committed to user feedback and responding to user needs. Most often, we
find changes being made in Acrobat, and all of Adobe’s products, as the result of a demand by a significant
number of users. For instance, you might wonder why a great feature is removed from one version of the
product. The answer may simply be that a number of IT managers were struggling with a security loophole
caused by the feature.

The change in Acrobat’s user interface was made because of a large demand by enterprise users who want
Acrobat to appear similar to other programs used, such as the Office products and Web browsers. You may
not agree, but Adobe can only respond to the majority and the majority is asking for something similar to
the look and feel of the current release.

Such changes require all of us to become familiar with some new ways to move around a document and
become familiar with the way your documents appear in an Acrobat window. As you can see in Figure 1.1,
the Acrobat workplace has changed appearance. For those familiar with earlier versions of Acrobat, you’ll
notice some obvious changes in the user interface.

FIGURE 1.1

The new Acrobat 8 user interface
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n Color Scheme. The Acrobat window has changed color because many users want to have more
emphasis on the document page and less on the Acrobat workspace. The contrast in color
between the background Document pane color emphasizes document pages more when the pages
are white. White is the most common page color used by most users.

n Elimination of the Status Bar. You’ll notice immediately that the familiar Status bar in Acrobat 8
is now absent. This decision was made to provide more viewing area for document pages. If you
like having tools previously found in the Status bar in view, don’t worry. I’ll explain how to create
a Status bar look in Chapter 5.

n Icons in the Navigation pane. Another obvious change in the user interface is the appearance of
icons in the Navigation pane at the far left side of the Acrobat window. Again, this change was
made to provide users more space in a crowded window. In earlier versions of Acrobat, we saw
names for the Navigation panels, such as Bookmarks, Pages, Security, Comments, Attachments,
and so on. These names took up quite a bit of real estate especially if you loaded a number of
additional Navigation panels made available by selecting View ➪ Navigation Panels and selecting
a panel from the submenu. After dragging a panel to the Navigation pane, the panels quickly
begin to crowd the available space. By using icons, you can easily store more individual panels in
the Navigation pane.

If you want to begin to associate the icons with the Navigation panel names, just open the
View ➪ Navigation Panels menu. All the Navigation panels are listed by icon and name,

including the default Navigation panels you see when you first launch Adobe Acrobat.

n Document windows with toolbars. This user interface change was again made because of strong
demand from users who wanted Acrobat to appear similar to other Windows and Macintosh pro-
grams. Although the view departs from Adobe’s Creative Suite programs, Adobe found more users
of Acrobat working in Microsoft Office and Internet Web browsers. Separate document windows
with toolbars associated with each window was the demand and Adobe responded. You can
choose in a preference setting whether to view PDF documents with or without toolbars attached
to each document.

Additional UI changes are discussed later in Chapter 5, along with some workarounds if you
happen to prefer the old Acrobat viewer look.

Acrobat Environment
Acrobat provides you with features such as menu commands, toolbars, and palettes to accomplish work for
whatever goal you hope to achieve with PDF documents. When you launch the program you see many of
these features in the Acrobat window. Just so you know what is being referred to when I discuss accessing a
feature in Acrobat, take a look at Figure 1.2 to understand the names used to describe the various areas of
the new Acrobat workplace.

A Title bar. By default, the name of the file you open appears in the title bar. The title appearing in
the title bar can change according to an option for displaying the Document Title in the Initial
View properties.

For information related to Initial View and displaying Document Titles, see Chapter 4.CROSS-REFCROSS-REF
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B Menu bar. The menu bar contains all the top-level menu commands. These menu choices are
also available from various actions associated with links and form fields when you choose the
Execute a menu item command in the Actions Properties dialog box for links, form fields, and
other features that permit associating an action with a command. When viewing files showing
toolbars and menus for each open document, the Acrobat window appears as shown in Figure
1.2. This view can be toggled off in a preference setting.

FIGURE 1.2

The Acrobat Professional workplace contains menus, toolbars, and palettes.

For information related to link actions and the Execute a menu item command action type, see
Chapter 22. For more information on actions with form fields, see Part VI. For making prefer-

ence choices for viewing PDFs, see “Customizing the Acrobat Workplace” later in this chapter. 
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C Toolbars. A number of individual toolbars are nested below the menu bar. When preferences are
set to view toolbars attached to each open document, you’ll see multiple sets of toolbars. Toolbars
are marked with a vertical separator bar at the left side of the toolbar. This bar can be selected and
dragged to move it out of the Toolbar Well.

For information related to working with toolbars, see the “Tools and toolbars” section later in
this chapter.

D Floating toolbar. Toolbars can be opened by accessing the More Tools drop-down menu and
selecting a toolbar name. When a toolbar is opened, it appears as a floating toolbar. Floating tool-
bars can be docked in the Toolbar Well.

E Toolbar Well. The Toolbar Well houses the toolbars. You can drag toolbars away from the Toolbar
Well or add other toolbars and expand the Toolbar Well to house your new additions. When you
drag a toolbar away from the Toolbar Well, the toolbar is “undocked” and becomes a floating tool-
bar. When you drag a floating toolbar and drop it in the Toolbar Well, the toolbar becomes
“docked.”

F Palette pull-down menu. Individual panels can be tucked away in the Navigation pane (see
Navigation pane later in this list) or appear anywhere in the Acrobat window. Each palette con-
tains its own menus accessible by clicking the down-pointing arrow. These menus are referred to
as palette pull-down menus in all subsequent chapters.

G Pages panel. When you open the Pages panel, you’ll see thumbnail images of each page in your
document and you’ll find many page-editing features available to you from the Pages panel palette
pull-down menu.

For information related to using the many options available in the Pages panel, see Chapter 16.

H Bookmarks panel. The second default panel appearing in the Navigation pane is the Bookmarks
panel. If bookmarks are contained in the PDF document, they appear in the palette when the
palette is open.

For information related to creating bookmarks from authoring programs, see Chapter 9. For
information related to creating and managing bookmarks in Acrobat, see Chapter 22.

I Signatures panel. If digital signatures are included in your PDF document, they can be viewed in
the Signatures panel.

For information related to digital signatures, see Chapter 26.

J How To. The How To pane has been moved in Acrobat 8 to the Navigation pane. In Acrobat 7,
this pane appeared on the right side of the document window. The How To pane contains some
help information related to many common PDF editing tasks. Users of previous versions of
Acrobat will notice the How To pane has replaced the default appearance of the Layers pane.

K Page thumbnails. When the Pages panel is opened, page thumbnails of all the document pages
appear within the Pages panel.
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CROSS-REFCROSS-REF

CROSS-REFCROSS-REF

CROSS-REFCROSS-REF

11

Getting to Know Adobe Acrobat 1

06_050514 ch01.qxp  12/29/06  11:13 PM  Page 11



L Attachments. The Attachments pane is used to show all file attachments in a document. 

To learn how to use file attachments, see Chapter 12. 

M Comments panel. When you open the Comments panel, the display of comments and reviews is
shown horizontally at the bottom of the Acrobat window.

To learn how to use the Comments panel options, see Chapter 20.

N Navigation pane. The Navigation pane can be expanded or collapsed. The view in Figure 1.1 is
an expanded view where the Bookmarks panel is the active pane. To open the Navigation pane
you can click a panel to display the respective information associated with that panel in the
expanded palette window. Clicking again on the panel collapses the view. You can also use the
keyboard shortcut F4 to expand and collapse the Navigation pane.

O Document pane. The Document pane is the container for PDF files you see in Acrobat. When no
file is open, the Document pane is empty. When you open a PDF document, the document
appears in the Document pane.

For more detail on specific menu commands, tools, and palettes, see the related chapters to discover the
different options available to you. All of the items discussed here are explained in more depth in subsequent
chapters.

Menus
As with any program operating on a computer system that supports a Windows type of environment, you’ll
notice menu commands at the top level of the Acrobat window. Users of previous versions will notice that
Acrobat 8 features an additional menu that contains commands specific to creating PDF forms. If at first
glance you don’t see an option you used in Acrobat 7, poke around the menus. None of the Acrobat 7 fea-
tures have been eliminated; they may just be in a different place or referred to by a different name. 

File menu
The File menu is where you open and close documents, create PDF files, import and export certain data,
access print commands, and find some other nifty new additions in Acrobat. The Mac and Windows operat-
ing systems display recent files in different menus. On the Mac in OS X you’ll find recently viewed docu-
ments by choosing File ➪ Open Recent File. This command opens a submenu where you can access recent
documents. On Windows, a list of the recently viewed documents is located at the bottom of the File menu,
as shown in Figure 1.3.

Note that a new menu command, Start Meeting, appears in the File menu. This command gets
you started with Adobe Breeze as I explain in Chapter 29.CROSS-REFCROSS-REF
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FIGURE 1.3

Recently opened files in Windows appear at the bottom of the File menu. Macintosh users can display a list 
of recently viewed files by choosing File ➪ Open Recent File.

Edit menu
As shown in Figure 1.4, the traditional Cut, Copy, and Paste commands are located in the Edit menu along
with other familiar commands from Acrobat 7. There are no changes to the Edit menu from Acrobat 7.

FIGURE 1.4

The Edit menu contains the same commands found in Acrobat 7.
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View menu
The View menu (see Figure 1.5) contains all the commands you’ll use for viewing PDF documents. An addi-
tion to the View menu is the Reading Mode command. This command dismisses the Navigation pane and
appears similar to the display you see when reading articles. The Wireframe command has changed to Line
Weights you see at the bottom of the menu.

For more information on using Reading Mode, see Chapter 5.

Document menu
The Document menu (see Figure 1.6) contains a collection of commands specific to document handling.
Options in the Document menu have a few changes in Acrobat 8 compared to the options in Acrobat 7.
Notice a new command — Enable Features in Adobe Reader, which appears in addition to Enable for
Commenting and Analysis found in Acrobat 7 and used to enable PDFs for commenting in Reader. This
new command now enables you to add both commenting and saving from data in Adobe Reader. The Paper
Capture command has changed names to Scan to PDF and a new command exists for optimizing scanned
PDF files. The OCR feature in Acrobat remains the same and is all available in the Text Recognition sub-
menu. In addition to these new commands, we find the Examine Document command and Manage embed-
ded index appearing in Acrobat 8.

For information related to enabling PDFs for form data saving, see Chapter 19 where all the
enabling features are discussed. For more information on examining documents, take a look at

Chapter 19. For more information on embedding index files, look to Chapter 6 where I talk about search
indexes and searching PDF files.

FIGURE 1.5

The View menu contains commands for viewing PDF documents and navigating through pages and different PDF
files. 
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FIGURE 1.6

The Document menu reflects several changes in Acrobat 8. 

Comments menu
Some new menu commands in the Comments menu shown in Figure 1.7 include Send for Shared Review,
Upload for Browser-Based Review, Search for Additional Services, and a number of different export com-
mands for exporting comments to MS Word, AutoCAD, and to a data file.

For details on working with comment reviews, see Chapter 21. For import/export commands
and all other commenting features, see Chapter 20.

FIGURE 1.7

The Comments menu offers commands specific to review and markups.
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Forms menu
The Forms menu shown in Figure 1.8 is new to Acrobat 8. Here you’ll find a number of different com-
mands all used for working with PDF forms and Adobe Designer XML forms (Windows). 

The new Run Form Field Recognition command is not only a special treat for forms designers,
but it’s one of the best new features added to Acrobat 8.

FIGURE 1.8

The Forms menu, new in Acrobat 8, contains commands specifically for working with forms.

For working with Acrobat PDF forms, see Chapters 33 and 34. For understanding more about
Adobe Designer and XML forms (Windows only), see Chapter 35.

Tools menu
The Tools menu (see Figure 1.9) in Acrobat logically places access to many editing tools in a single conven-
ient menu. You can access certain tools from the Acrobat toolbars (explained in the section “Tools and tool-
bars” later in this chapter) or you can use a context menu to access toolbars from the Acrobat Toolbar Well.

FIGURE 1.9

The Tools menu contains a collection of tools accessed from submenus. Select a tool group from the menu options
to open a submenu.

Advanced menu
The Advanced menu (see Figure 1.10) contains a collection of menu commands considered to be advanced
Acrobat features. A few of these tools are not available to users of Acrobat Standard such as Batch
Processing, the new Redaction tools in Acrobat 8 Professional, and access to Acrobat Catalog. A few changes
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have been made in this menu in Acrobat. You’ll notice the Security commands have changed a bit and a
new command exists for enabling PDFs with Adobe Reader usage rights. Also notice the Document
Processing menu command. From the submenu you find many command that were positioned directly
under the Advanced command such as Batch Processing, And JavaScript commands.

For more information on using the Redaction tools, see Chapter 14.

FIGURE 1.10

The Advanced menu offers menu commands related to advanced editing features.

For information related to Batch Processing, see Chapters 18 and 36. For information on using
Acrobat Catalog, see Chapter 6. For information on using all the security commands see

Chapter 26. For information on enabling PDFs with Adobe Reader usage rights, see Chapter 19.

Window menu
The Window menu (see Figure 1.11) provides menu commands to assist you in viewing documents. 

FIGURE 1.11

The Window menu handles all the window views such as tiling, cascading, and splitting windows.
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For information related to window views and the split window views, see Chapter 5.

Help menu
The traditional help files added to your Acrobat folder at installation are found in the Help menu (see
Figure 1.12). Various online help support is also located in this menu. You’ll note that the Detect and Repair
command found in earlier versions of Acrobat has changed to Repair Acrobat Installation.

For information related to Help documents and Help menus, see the “Accessing Help” section
later in this chapter.

Submenus
An extensive number of submenus appear in menus contained in the top-level menu bar and from many
different tools contained in toolbars. Note that on individual toolbars you see a down-pointing arrow.
Clicking the arrow opens a menu; some menus contain submenus. A submenu is denoted in Acrobat by a
right-pointing arrow on the right side of a given menu command as shown in Figure 1.13. Select a com-
mand with one of these arrows adjacent to the command name and a submenu opens. In a few cases, you
can find nested submenus where another right-pointing arrow may be visible in a submenu. If you want to
access the second submenu, move the cursor to the menu option containing a right-pointing arrow. To
make a selection from a submenu command, move the cursor to the desired menu command. When the
menu command highlights, click the mouse button to execute the command.

FIGURE 1.12

The Help menu gives you access to Help information on selected topics as well as access to the complete Acrobat
Help document.
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FIGURE 1.13

To access a submenu, move the cursor to the command containing a right-pointing arrow and slide the cursor over
to the submenu options. Click the desired command in the submenu to execute the command.

Context menus
Wherever you are in the Acrobat window — the toolbars, palettes, Document pane, or the Help menus —
you can gain quick access to menu items related to your task by opening a context menu. Context menus
pop up in an area where you either click the right button on the mouse or use an appropriate key modifier.
In Windows, right-click the mouse button to open a context menu. On a Macintosh, when not using a two-
button mouse, press the Control key and click the mouse button. Context menu options relate to the partic-
ular tool you have selected from a toolbar. By default the Hand tool is selected when you launch Acrobat
and open a PDF document. When you right-click the mouse button (Windows) or Ctrl+click (Macintosh), a
context menu pops up where you click the mouse as shown in Figure 1.14.

FIGURE 1.14

With the Hand tool selected, right-clicking (Windows) or Ctrl+clicking (Macintosh) the mouse button opens a con-
text menu. From the menu, scroll the list and select the desired menu command.
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If you change tools in a toolbar and open a context menu, the menu options change to reflect choices with
that particular tool. Likewise, a context menu opened on a palette offers menu options respective to the
palette, as shown in Figure 1.15.

FIGURE 1.15

When a palette is open in the Navigation pane and you open a context menu, the menu options reflect tasks you
can perform respective to the panel.

Opening a context menu on one of the icons in the Navigation pane opens a menu where you
can add or remove panels from the pane. Additionally, you can hide the Navigation panel

icons by opening a context menu in the Navigation pane and select Hide Navigation Pane Buttons. To bring
back the Navigation Pane Buttons, press F4 on your keyboard or select View ➪ Navigation Panels ➪ Show
Navigation Pane.

Context menus are a great benefit during your Acrobat sessions and using them helps you work much
faster. Throughout this book I often make references to the different choices you have in selecting a tool or
command. In most incidences, you find mention of context menus. Be certain you know how to open a
context menu in Acrobat on your computer. For the remainder of this book, I’ll mention opening context
menus without walking through the steps for how to open the menu.

Keyboard shortcuts
Pressing one or more keys on your keyboard can also open menus and invoke different commands. When
you become familiar with keyboard shortcuts that perform the same function as when using a menu or con-
text menu, you’ll find yourself favoring this method for making different menu selections or grabbing a tool
from a toolbar. Fortunately, you can learn as you work when it comes to memorizing keyboard shortcuts. As
I’m certain you know, several shortcut combinations are noted in menu commands. You can learn these
shortcuts when you frequently use a particular command. However, the keyboard shortcuts you see in the
menu commands are just a fraction of what is available in Acrobat for quick access to commands and tools.
For a complete list of all keyboard shortcuts, look over the Complete Acrobat help document you open by
selecting Help ➪ Complete Acrobat 8.0 Help.

Pressing a single key to access a tool requires you to have your Preferences set to accept single
keystroke shortcuts. See the steps for “Setting up the Acrobat environment” later in this chap-

ter for the proper Preferences settings.

NOTENOTE
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Tools, task buttons, and toolbars
Tools are grouped together in separate toolbars in the Toolbar Well below the menu bar. The default view
when you launch Acrobat contains several toolbars visible in the Toolbar Well. You can remove various tool-
bars from the Well, move them around the Acrobat window, close them, and add different toolbars to the
Toolbar Well. 

In addition to loading and unloading toolbars, a new feature in Acrobat 8 permits you to add
or remove individual tools from any toolbar. Before you learn how to add and remove individ-

ual tools, let’s first take a look at the Toolbar Well.

The Toolbar Well, where the toolbars are contained, is collapsed and expanded according to the number of
toolbars you add to it. When a toolbar is contained within the Toolbar Well, it is said to be docked. When a
toolbar is dragged away from the Toolbar Well and rests atop the Acrobat window, it is said to be undocked
and appears as a floating toolbar.

Task buttons
One of the many different toolbars in Acrobat is called the Tasks toolbar. This toolbar houses various Task
buttons. In Figure 1.16 the tasks toolbar is shown with the label descriptions to describe each tool’s pur-
pose. Task buttons differ a little from other tools in that they all support pull-down menus where menu
commands related to specific tasks are addressed.

FIGURE 1.16

The Tasks toolbar contains several Task buttons all containing pull-down menus.

The Tasks toolbar features commands for creating PDFs, working with comments and reviews, exporting
PDFs to different formats, securing PDFs, working with forms, and digitally signing PDFs. The Tasks tool-
bar also features the new Task button containing commands for engaging in Acrobat Connect meetings.
You’ll find all these features covered in many of the following chapters.

Loading and unloading tools
The default tools you see in the Toolbar Well when you first open Acrobat is but a mere fraction of all the
tools available to you. Fortunately in Acrobat 8, a nifty new window has been added to the program to help
you easily manage tools.

It’s important to realize that you have toolbars and tools. Tools appear as individual icons contained in a
given toolbar. You can choose to show only one tool in a toolbar or all the tools that belong to a given tool-
bar and anything in between. The tools within toolbars can be added and deleted from the parent toolbar.

If you’re familiar with earlier versions of Acrobat and you don’t find tools loaded in the various toolbars, your
first stop is to open the More Tools menu at the top right corner of your screen. Select More Tools from a
context menu opened on the Toolbar Well and the More Tools window opens as shown in Figure 1.17.

NEW FEATURENEW FEATURE
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FIGURE 1.17

Open the More Tools window to show/hide tools in toolbars.

Place a check mark beside any tool to be shown in a toolbar docked in the Toolbar Well or opened as a
floating toolbar. Figure 1.17 shows you a small portion of available tools that appear in a scrollable window.

Toolbars themselves can be shown or hidden using the More Tools window. If you remove a
check mark adjacent to a toolbar name to hide the toolbar, the toolbar and all the tools are

hidden, even if the individual tools are all checked.

Yet another way to add and remove tools to and from toolbars is to simply open a context menu on a tool-
bar. Right-click (Windows) or Ctrl+click (Macintosh) on a toolbar either docked in the Toolbar Well or as a
floating toolbar and a pop-up menu provides options for adding or removing tools to/from that toolbar
group. 

In Figure 1.18 a context menu is opened on the Edit toolbar. When Show/Hide Tools is selected a sub-
menu displays all toolbars. Select an item unchecked to open the respective toolbar or select a checked 
toolbar to remove hide it. Note that hiding a toolbar is temporary and only hides the toolbar from view in
the Toolbar Well.

NOTENOTE

22

Welcome to Adobe AcrobatPart I

06_050514 ch01.qxp  12/29/06  11:13 PM  Page 22



FIGURE 1.18

Open a context menu on a toolbar and select Show/Hide Toolbars to open a submenu where all toolbars can be
opened or temporarily closed.

If you want all tools within a given toolbar to be shown, select Show All Tools in the context
menu.

The Show/Hide menu command in the context menu shown in Figure 1.18 provides the same commands
you have available in the View ➪ Toolbars submenu. Either of these menus provides you a quick and easy
way to show and hide toolbars.

The last menu item in the context menu shown in Figure 1.18 is used to open the More Tools window
where you can add/remove tools among all toolbars.

Default toolbars
When you launch Acrobat for the first time or you set the toolbars to the default view, six different toolbars
are docked in the Toolbar Well, including the Tasks toolbar discussed earlier in this section. The remaining
default toolbars include:

n File toolbar. These tools are used for general document handling. The default File tools activate
commands for Open, Save, Print, and Email. When all the tools are loaded in the File toolbar the
Create PDF from web page and Attach a File tools are added to the toolbar. In Figure 1.19 the
default File toolbar appears on the left and the expanded File toolbar showing all tools appears on
the right.

TIPTIP
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FIGURE 1.19

The File toolbar contains tools for document handling, such as opening PDF documents,
saving documents, and printing files.

n Page Navigation toolbar. The default tools in the Page Navigation toolbar shown on the left in
Figure 1.20 contain tools for moving back and forth between PDF document pages. The numbers
indicate what page you are currently viewing out of the total number of pages in the document.
When the toolbar is expanded to show all tools as you see on the right in Figure 1.20, the First
Page, Last Page, Previous View, and Next View tools are shown.

FIGURE 1.20

The Page Navigation toolbar, as the name implies, contains tools for navigating document
pages.

n Page Display toolbar. The Page Display toolbar is the home of many different tools used for page
viewing, but only two of the tools appear in the default toolbar as shown in Figure 1.21 on the
left. When you first open Acrobat, you see the Scrolling Pages and One Full Page tool. After
expanding the toolbar to show all tools as shown on the right in Figure 1.21, the Single Page
Continuous, Single Page, Two-Up, Two-Up Continuous, Full Screen Mode, Rotate
Counterclockwise, Rotate Clockwise, and Line Weights tools are shown. Users of earlier versions
of Acrobat will note that the tool names for Single Page, Continuous, Continuous – Facing, and
Facing Pages have changed names to Single Page, Single page Continuous, Two-Up Continuous,
and Two-Up respectively. In addition, these four tools previously appeared in a Status bar at the
bottom of the Acrobat window in earlier versions of Acrobat. In Acrobat 8, the Status bar has
been eliminated and all tools appear at the top of the Acrobat window.

FIGURE 1.21

The Page Display toolbar contains many tools used for page viewing.

n Select & Zoom toolbar. The tools in this group are used to select text/images, move the page in
the Document pane, and zoom in and out of pages in the Document pane. The left side of Figure
1.22 shows the Select tool followed by the Hand tool then the Zoom Out, Zoom In, and Zoom
Value tools. When all tools are loaded the Actual Size, Fit Width, Fit Page, Pan & Zoom Window,
Loupe tool, and Snapshot tool appear as shown in Figure 1.22 on the right.
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FIGURE 1.22

Select & Zoom tools are used to select text/images, move a document around the
Document pane, copy selections, and view the document page using a number of different
zoom tools.

n Find toolbar. Of all the default toolbars, the Find toolbar shown in Figure 1.23 is the only one
that does not have additional tools that can be added to the toolbar. However, a pull-down menu
exists for making choices to refine your search for words in an open PDF document.

For more information on searching PDFs, see Chapter 6.

FIGURE 1.23

The Find toolbar is used for searching words in a PDF document.

Managing default toolbars
In addition to loading and unloading tools within toolbars, the toolbars can be moved, docked, and
undocked from the Toolbar Well. Here’s a list of some of the things you can do with the default toolbars and
any other toolbars you decide to view:

n Undocking toolbars. Toolbars can be relocated from within the Toolbar Well to another area
within the Acrobat window. For example, you might find it more convenient to move a toolbar
you frequently access during an editing session so it is positioned at the bottom of the Document
pane. If so, just place the cursor on top of the vertical separator bar adjacent to the first tool in a
toolbar and drag it away from the Toolbar Well. This vertical line is the hot spot used to select the
toolbar instead of a tool in the group. Clicking anywhere else in the toolbar selects a tool.

n Docking toolbars. To dock a toolbar back in the Toolbar Well once removed, drag the toolbar,
again by the vertical separator bar adjacent to the first tool, on top of the Toolbar Well. The toolbar
snaps to an available position in the Well. If you drop the toolbar between two other toolbars, the
toolbar you relocate back to the Toolbar Well snaps in position between the two docked toolbars.

Toolbars can also be docked vertically on the left and right sides of the Document pane and at the
bottom of the Acrobat window below the status bar. For example, if you drag a toolbar to the left
of the Navigation pane and release the mouse button, the toolbar snaps to a docking station and
the tools display vertically. In Figure 1.24 you can see toolbars docked on the left (A), right (B),
and bottom (C) of the Acrobat window with one floating toolbar (D) in the Document pane.

CROSS-REFCROSS-REF
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FIGURE 1.24

Toolbars can be docked on all four sides of the Acrobat window and undocked from the
Toolbar Well where they appear as floating toolbars.

n Resetting toolbars. You can position toolbars around the Acrobat window and return them to the
default positions with one menu command. This is particularly helpful if multiple users work on
a single computer or you frequently change editing tasks that require using different tools during
different editing sessions. In many cases it’s easier to reset toolbars to the original default view,
than open tools needed for a specific editing task. To set toolbars to their defaults, open a context
menu from any toolbar or in the Toolbar Well by right-clicking (Ctrl+clicking on Macintosh), and
select the menu item Reset Toolbars as shown in Figure 1.25. Alternately, you can press
Alt/Option+F8.

D B

A C
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FIGURE 1.25

To return toolbars back to the default view, open a context menu from any toolbar or in the
Toolbar Well and select Reset Toolbars.

n Hiding all toolbars. Toolbars can be hidden from view to offer you more room when editing a
PDF document or browsing the contents of PDFs. To hide the toolbars from view, open a context
menu from the Toolbar Well and choose Hide Toolbars. When toolbars are hidden you won’t have
access to a context menu to get the toolbars back in view. Instead, choose View ➪ Toolbars ➪
Show Toolbars to make all toolbars reappear. (Note that using this menu command also hides
toolbars.)

n Hiding a single toolbar. You can hide a toolbar after it has been undocked from the Toolbar
Well. Click the X in the top-right corner of the toolbar (Windows) or the small circle on the top-
left side of the toolbar (Macintosh) to close it, and it disappears from view. From a context menu
opened on any toolbar or the Toolbar Well, you can open the toolbar and display it in the Acrobat
window again. Toolbars can also be hidden by using the More Tools window, opening a context
menu on the Toolbar Well and selecting a toolbar with a check mark to hide it, and selecting tool-
bars in the View ➪ Toolbars submenu.

n Locking toolbars. The vertical separator bar used to move toolbars disappears when you select
Lock Toolbars from a context menu. The toolbars cannot be inadvertently moved after you lock
them. To unlock the toolbars, open a context menu and select Lock Toolbars again. The check
mark alongside the menu command becomes unchecked and the toolbars are unlocked in the
Toolbar Well. If the toolbars are locked and you drag an undocked toolbar on top of the Toolbar
Well, it won’t dock. You need to first unlock the toolbars before you can redock them.
Additionally, you need to unlock toolbars in order to use the Reset Toolbars command in a
Toolbar Well context menu to return tools and toolbars back to the default position.
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You can also lock toolbars that are undocked outside of the Toolbar Well. The separator bar on
the toolbar disappears on floating toolbars the same as it does for toolbars docked in the Toolbar

Well. However, locking undocked toolbars does not prevent you from moving them around the Acrobat win-
dow. You can click and drag the title bar for any undocked toolbar and move it to another location.

n Setting new toolbar defaults. If you decide to reposition your toolbars and want to keep them
fixed as new defaults, Acrobat can do so for you automatically. Move the toolbars to the desired
locations and go about your work. When you quit Acrobat and reopen the program, the toolbar
positions remain as you last arranged them. Unfortunately, Acrobat does not have a Save
Workspace command like you find in several Adobe Creative Suite applications.

If you are unfamiliar with many Acrobat tools, you can change the tool labels to show you a
more descriptive label for each tool that offers you a hint of what the tool does. To show more

descriptive labels, open a context menu on the Acrobat Toolbar Well and choose Show Button Labels ➪ All
Labels. The toolbars expand and show a text description for each tool’s name. Keep this option active until
you are familiar with the tool names.

Understanding advanced toolbars
The default toolbars represent a fraction of the tools available to you in Acrobat. Many of the other toolbars
remain hidden from view. The reason for this is obvious when you load all the toolbars in the Toolbar Well.
You lose a lot of viewing real estate when all toolbars are docked in the Toolbar Well. Unless you have a
large display monitor or a second monitor, working on a file in the Document pane when all toolbars are in
view gives little room to see document pages. Fortunately, by managing the toolbars you can elect to show
only the tools you want to work with and you can move them around the Acrobat window, allowing for the
best view.

You open toolbars from menu commands in the Tools menu or by opening a context menu. If you’re a sea-
soned Acrobat user, your first encounter with Acrobat viewers 6 and above might be a bit frustrating if you
don’t know how to access the tools you want to use. “Where is that Form tool?” you may ask. Don’t worry;
it’s there. You just have to poke around and search for it or, better yet, look over the following descriptions
to understand more about how these other tools are grouped into separate toolbars.

Opening advanced toolbars
For the purpose of discussion, I’ll refer to the non-default toolbars as advanced toolbars. Acrobat does not
refer to all these tools as advanced tools. Some of the tools labeled in the menu commands are not referred
to as advanced tools. For clarity in this chapter, though, consider all the following toolbars as advanced
toolbars.

You can use three methods for displaying toolbars not visible when you open Acrobat. You can open the
View ➪ Toolbars menu where you find a list of tools in submenus. Select a submenu item to open a toolbar
as a floating toolbar in the Acrobat window. Another method is to open a context menu on the Toolbar Well
and open toolbars from commands in the menu. A third option, and one that provides more options for
viewing all tools and toolbars in a single window, is to use the More Tools menu command when you open
a context menu on the Toolbar Well. As a matter of routine, you should use this option when preparing an
Acrobat session that requires you to use several tools and toolbars. All tools except the Form tools (Acrobat
Professional only) are accessible from the context menu.

Advanced Editing toolbar
The Advanced Editing toolbar shown in Figure 1.26 is one you’ll use in just about all Acrobat editing 
sessions. Tools include the Select Object tool that is used to select content you add in Acrobat such as 
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comment markups and form fields. The Article tool is used to create article threads, the Crop, Link, 3D,
Movie, and Sound tools follow. The TouchUp Text tool is used to edit text on a page and the last tool is the
TouchUp Object tool that is used to select content that was originally created in an authoring program and
converted to PDF.

For more information about PDF editing using the Advanced Editing tools, see the chapters in
Part III. To learn more about the Link tool, see Chapter 22. For using the Movie and Sound

tools see Chapter 23. To learn how to use the TouchUp Order tool that follows the TouchUp Text tool, see
Chapter 25.

FIGURE 1.26

The Advanced Editing toolbar contains a miscellaneous group of tools used for many different editing functions.

Comment & Markup toolbar
When you open either the View ➪ Toolbars submenu menus or a context menu on the Toolbar Well, the
first menu option after the default Advanced Editing toolbar is the Comment & Markup toolbar. Select the
menu option and the Comment and Markup tools open in their own toolbar. Open a context menu on the
toolbar and select Add/Remove Tools ➪ Show All Tools. The toolbar appears as you see in Figure 1.27
when all tools are loaded.

FIGURE 1.27

Open the Comment & Markup toolbar and open a context menu on a tool and select Show All Tools to see all the
comment and markup tools.

Now in Acrobat 8 you have the opportunity to load just the tools you want to use in a review
session from both the former Commenting and the Drawing & Markup toolbars. Acrobat 8

nests all these tools together nicely in a single toolbar. This arrangement affords you the opportunity to view
just those tools you commonly use in a review session — a great new feature. I won’t go into all the tool
names and explain their use now. You’ll find a complete description in Chapter 20.

When you select the Comment & Markup tools from the More Tools window and check the
boxes for all tools, all the tools are loaded except the Paste a copied image as stamp tool. To

show the tool in the Comment & Markup toolbar, open the Comment & Markup toolbar and open a context
menu on any tool in the toolbar. Select Show All Tools and the Paste a copied image as stamp tool is added to
the toolbar.

Edit toolbar
The Edit toolbar is the home of a miscellaneous group of editing tools, such as spell checking, copy, paste,
undo, and redo. (See Figure 1.28.)

TIPTIP
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FIGURE 1.28

The Edit toolbar contains a miscellaneous selection of tools used for spell checking and editing.

Forms toolbar (Acrobat Professional only)
From a context menu in the Toolbar Well or the View ➪ Toolbars submenu select Forms toolbar to open
the Forms tools. The eight forms tools shown in Figure 1.29 opens where you can access tools to create
form fields.

In addition to the same form tools you had available in Acrobat 7, a new tool is added to the
toolbar to create bar code fields. In addition two other new tools are added to the Forms tool-

bar. The Edit Layout tool changes from a preview mode to a form editing mode and the Distribute tool used
to distribute forms for an ad hoc data collection and enable the distributed forms for Adobe Reader users.

FIGURE 1.29

To access the Forms toolbar, open a context menu on the Toolbar Well and select Forms.

For more information on using the Forms tools and the new tools added to Acrobat 8, see
Chapters 33 and 34.

Measuring tools
The Measuring tools include the Distance tool used for measuring linear distances, the Perimeter tool for
measuring linear distances of angles and objects, and an Area tool for measuring the surface area of objects.
The Measuring toolbar, shown in Figure 1.30, might be used for examining measurements in engineering
and scientific drawings.

For more information about using the Measuring tools, see Chapter 24.

FIGURE 1.30

The Measuring toolbar offers three tools to measure distances and areas on a PDF page.

Object Data tool
The Object Data tool (see Figure 1.31) is used to select objects on a document page. When you select an
object that has object data associated with it, the Object Data dialog box opens. This dialog box contains
object metadata such as creation date, copyright information, color mode, resolution, and other file attrib-
utes similar to the kind of metadata you can view in programs such as Microsoft Visio, Microsoft Project,
and AutoDesk AutoCAD. 
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For a greater understanding about object and document metadata, see Chapter 5. For informa-
tion on using the Object Data tool, see Chapter 9.

FIGURE 1.31

Use the Object Data tool to select objects and view file attributes associated with the selected object.

Print Production tools
The Print Production tools (see Figure 1.32) enable you to make adjustments on the PDF or alter the con-
tent. This toolbar contains tools for assigning traps, pre-flighting, converting colors, assigning color profiles,
adding crop marks, cropping pages, fixing hairlines, transparency flattening, and assigning Job Definitions.

FIGURE 1.32

Use the Print Production tools to open dialog boxes where you can preview and change PDF documents to accom-
modate prepress and commercial printing.

For more information on using Print Production tools and preparing files for commercial print-
ing, see Chapter 32.

Redaction
A new toolbar has been added to Acrobat 8. The Redaction tools are particularly helpful for users working
in the legal industry who need to remove text content from documents to protect sensitive data such as the
names of minors, personal privacy information, and data breeching security policies. When you open the
Redaction toolbar you’ll see four tools to help you redact PDF documents as shown in Figure 1.33.

FIGURE 1.33

Redaction tools are used to remove sensitive information from PDF documents.

For a complete explanation for redaction and using the Redaction tools, see Chapter 14.

Typewriter toolbar
The Typewriter tool was added to all Acrobat viewers in a maintenance upgrade during the Acrobat 7 life
cycle. This toolbar, shown in Figure 1.34, contains tools for typing text on PDF documents. It’s particularly
helpful when filling out PDF forms that don’t have form fields.

CROSS-REFCROSS-REF

CROSS-REFCROSS-REF

CROSS-REFCROSS-REF

31

Getting to Know Adobe Acrobat 1

06_050514 ch01.qxp  12/29/06  11:13 PM  Page 31



FIGURE 1.34

The Typewriter tool is used primarily for filling in forms that don’t contain form fields. 

For more information on using the Typewriter tools, see Chapter 33.

Properties Bar
You use the Properties Bar (see Figure 1.35) in conjunction with several different tools. After you create
comments, links, buttons, and similar content in a PDF document, the selected comment, link, button, and
so on displays current properties such as colors, fonts, and line weights in the Properties Bar. You can make
changes in the Properties Bar without visiting the Properties dialog box. You can quickly open the
Properties Bar with a keyboard shortcut (Ctrl/Ô+E) or via a context menu opened on the Toolbar Well.

FIGURE 1.35

The Properties Bar offers a quick solution for editing item properties without the need for opening dialog boxes.

Customizing the Acrobat workplace
Whether you’re an Acrobat pro or a new Acrobat user, seeing all those toolbars loaded and scattered across
the Toolbar Well the first time can be very intimidating. As you poke around and possibly feel a little frus-
tration when trying to identify the right tool icon to select the right tool for the task at hand, please realize
that Acrobat is a multifaceted program serving a huge array of needs for different users. Not all the tools and
features are designed for use in a single Acrobat session. You may be a PDF forms author and need only
Basic tools, Navigation tools, Edit tools, and Form tools. In another session you may be a reviewer and only
have need for the Comment and Markup tools. You might be an eBook author and need to work with many
features for creating and viewing eBooks, or you might want to edit PDF pages and post modified PDFs on
your Web site.

When learning all the tools and commands contained in Acrobat Professional, be certain to look over all the
chapters where tools are discussed. Learn how to access toolbars and organize them in the Toolbar Well.
When you begin a new Acrobat session, set up your environment so you can easily select a tool from tool-
bars you dock in the Toolbar Well.

As a starting point, you can configure Acrobat to provide you with immediate feedback related to tools
selection and keyboard shortcuts. As you first start using Acrobat Professional, follow the steps in the next
section to help you customize your environment for more efficient editing and less frustration. In this exam-
ple, an environment for engaging in a commenting session is used. You can change the toolbars to meet
needs in PDF editing or PDF creation, or add tools for some other kind of work you do.

CROSS-REFCROSS-REF
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STEPS: Setting up the Acrobat environment

1. Return to toolbar defaults. Open Acrobat. Position the cursor on any area in the Toolbar Well
and right-click to open a context menu (Ctrl+click for Macintosh) and select Reset Toolbars.

2. Open the More Tools window. Open the More Tools menu. From a context menu opened from
the Toolbar Well, select More Tools to open the More Tools window.

3. Add the tools you intend to use to the Comment & Markup toolbar. This is a personal choice.
Look over all the Comment & Markup tools and check just those tools you intend to use. Be cer-
tain to check the box for the Comment & Markup toolbar so the toolbar shows up when you
leave the More Tools window. (See Figure 1.36.)

FIGURE 1.36

The More Tools window

4. Add some Edit tools. While still in the More Tools window, scroll to the Advanced Editing
Toolbar. One tool you’ll use frequently in almost all editing sessions is the Select Object tool
(denoted with an arrowhead icon). Click the check box for this tool. Other tools won’t be used
under most circumstances such as the Movie tool, Article tool, Link tool, and so on. Uncheck all
the tools you anticipate not using.

5. Add the Spell Check tool. Scroll to the Edit toolbar and check the Spell Check tool.

6. Exit the More Tools window. When certain about the tools you think you’ll use in a given edit-
ing session, click OK and all the toolbars open as floating toolbars.

7. Open the Properties Bar. Again open a context menu on the Toolbar Well and select Properties
Bar from the menu options. Note that this tool is not available in the More Tools window and
needs to be opened from a context menu or the View ➪ Toolbars submenu.
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8. Dock the toolbars. After opening all the toolbars you want to use for a given editing session
return to the Toolbar Well context menu and select Dock All Toolbars. This command moves all
the toolbars to the Toolbar Well, as shown in Figure 1.37.

FIGURE 1.37

Toolbars docked in the Toolbar Well include the A) File toolbar, B) Select & Zoom toolbar,
C) Advanced Editing toolbar, D) Edit toolbar, E) Comment & Markup toolbar, and F) the
Properties Bar.

Tool Tips
When you select All Labels from a context menu or preference setting, you see tool descriptions on many
tools. However, not all tools describe the tool with a label. For example, look at the Zoom In tool (the plus
symbol). It should be apparent to you what the tool does by viewing the icon in the toolbar. Other tools’
functions, however, may not be so apparent from viewing the tool icons. Fortunately, you have some extra
help in the form of Tool Tips. To view a Tool Tip, place the cursor over a tool in the Toolbar Well or on a
floating toolbar, and pause a moment before selecting the tool. A Tool Tip appears inside a yellow box
directly below the cursor with a label describing the tool. In Figure 1.38 you can see the Tool Tip that
appears when the cursor is placed over the Sticky Note tool. As you move the cursor over different tools,
the Tool Tips change to reflect the description of the targeted tool.

FIGURE 1.38

Place the cursor over a tool and pause a moment before selecting the tool. A Tool Tip describing the tool opens
below the mouse cursor.

A DC B

F E
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As you become familiar with the tools, you can return to the context menu opened from the Toolbar Well
and choose Button Labels ➪ No Labels. When No Labels is active, your toolbars shrink and offer you more
room in the Toolbar Well.

Palettes
Other tools available to you in all Acrobat viewers are palettes. Palettes are similar to toolbars in that they
can be docked to a docking station called the Navigation pane; they can be undocked and floated around
the Acrobat window; they can contain pull-down menus for selecting more options; a series of default
palettes appears docked in the Navigation pane; and you can open additional palettes from menu 
commands.

A couple distinctions between toolbars and palettes are that palettes can be placeholders for information,
and tools can appear inside a palette. Whereas tools are used in the Document pane, many palette opera-
tions take place directly in the palette. Toolbars remain relatively fixed in size, but palettes can be sized and
stretched along the Acrobat window to provide you with more room to work within the palette or view the
information contained within the palette. In addition, some palettes contain their own tools where edits can
be made in the palette and dynamically reflected on the document page. Palettes help you organize content,
view specific content across many pages, and provide some tools for global editing of PDF files.

Default palettes
As with toolbars, Acrobat displays a series of palettes docked in a well when you first launch the program.
Palettes are contained in the Navigation pane along the left side of the Acrobat window. By default, the
Navigation pane is collapsed; however, you can save PDF documents in such a manner where a palette
expands when a file is opened in any Acrobat viewer. These settings are document-specific and can be tog-
gled on or off for individual PDF documents.

For more information about setting opening views for palette displays, see Chapter 4.

Pages
Acrobat users have been familiar with the thumbnail view of each page since the early days of Acrobat. 
A mini view of each page in the active PDF document is displayed in the Pages pane, as shown in Figure
1.39. The Pages pane offers you menu options for arranging, deleting, inserting, and editing pages in a
number of ways. You can zoom in to the thumbnail views as large or even larger than a page viewed in the
Document pane.

CROSS-REFCROSS-REF

35

Getting to Know Adobe Acrobat 1

06_050514 ch01.qxp  12/29/06  11:13 PM  Page 35



FIGURE 1.39

Thumbnails are found in the Pages pane in all Acrobat viewers. The thumbnail view of document pages can be sized
larger and smaller using context menu commands.

For a complete description of working with pages (thumbnails), see Chapter 16.

Bookmarks
The second default palette panel in the Navigation pane is the Bookmark panel. You can save PDF docu-
ments in a manner where the bookmarks are visible when the file opens in Acrobat. A good example of
such a file is a Help file. When you open a file such as the Adobe Designer FormCalc file, bookmarks are
visible in an open Navigation pane, as shown in Figure 1.40. You can open and close the Navigation panel
by pressing F4. You can also grab the vertical separator bar at the right edge of the Navigation pane and
move it left and right to size the pane.

FIGURE 1.40

Bookmarks can be displayed in the Navigation pane when a file opens.
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Bookmarks are navigation buttons that can launch a page, a view, or one of many different Action types
similar to link and button actions. Anyone familiar with Acrobat already knows much about bookmarks
and how to navigate pages by clicking individual bookmarks in the palette.

To learn how to create and manage bookmarks and add actions, see Chapter 17.

How To
The How To pane has been moved from where it appeared in Acrobat 6 and 7. In Acrobat 8, the How To
pane is docked in the Navigation pane and its behavior is similar to other palettes. Here you find help infor-
mation on some key Acrobat editing tasks. Click the links shown in Figure 1.41 and the help information is
displayed in the pane.

For more information on getting help in Acrobat, see the section “Accessing Help” later in this
chapter.

Signatures
Digital signatures help you manage signed documents; the Signatures panel enables you to perform tasks
such as displaying signatures in the Signature pane, verifying signatures, clearing them, deleting them, and
so on. All these editing tasks with signatures are still available in Acrobat Professional as is signature valida-
tion, which is also available in other Acrobat viewers.

For a complete description of creating and managing digital signatures, see Chapter 26.

FIGURE 1.41

The How To pane provides help information on key Acrobat editing topics.
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Attachments
The Attachments pane (see Figure 1.42) in all Acrobat viewers is used to display, manage, and extract file
attachments. You can attach files in Acrobat Standard and Professional and extract file attachments using all
Acrobat viewers including Adobe Reader.

FIGURE 1.42

The Attachments pane provides options for managing file attachments. Attachments can be extracted from within
Adobe Reader.

For a complete description of adding file attachments to PDF documents, see Chapter 15. For
more on extracting attachments from within Adobe Reader, see Chapter 3.

Comments
The Comments palette shows you comments in an expanded horizontal view, just like the Attachments
pane. When you click the Comments panel, you’ll notice a number of pull-down menus (signified by
down-pointing arrows at the top of the pane), a list of comments that can be expanded and collapsed, and a
host of tools within the palette, as shown in Figure 1.43.

FIGURE 1.43

The Comments palette

For a complete description of creating and managing comments, see Chapters 20 and 21.

Hidden panels
As with toolbars, you can choose to view additional panels through menu commands. You can choose to
display a number of other panels in the Acrobat window and dock them in the Navigation pane. To open a
hidden panel, choose View ➪ Navigation Panels. From the submenu, you’ll find all the panels available. In
Figure 1.44, the list shows Navigation panels available in Acrobat Professional. 

Another way to access the Navigation panels is through a context menu. Right-click (Windows) or
Ctrl+click (Macintosh) on the Navigation pane and a menu shows all the Navigation Panels. In order to see
the panels, you must first open them from the Navigation Panels submenu and dock them in the Navigation
pane. Once the panels have been docked, they appear in a context menu, as shown in Figure 1.45.
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FIGURE 1.44

Open the Navigation Panels menu and a submenu displays all Navigation panels.

FIGURE 1.45

Once Navigation panels have been docked in the Navigation pane, they appear in a context menu opened from the
Navigation pane.
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The list includes the default panels. If you select a default panel, the Navigation pane opens and the panel is
selected. When you select a hidden panel, in other words, a panel other than those docked in the
Navigation pane when you first launch Acrobat, the panel opens in the Acrobat window as a floating palette
with one or more panels contained in the window. Drag a panel to the Navigation pane and it docks and
then becomes visible in a context menu opened from the Navigation pane.

Articles
The first of the hidden panels listed in the Navigation Panels submenu is Articles. Choose View ➪
Navigation Panels ➪ Articles to open a floating palette. Articles enable you to create article threads to help
users follow passages of text in a logical reading order. You won’t find any new features added to the Article
tool since Acrobat 5.

For information on creating article threads and managing them, see Chapter 16.

Content
A palette designed for managing the structural content of PDF documents is found in the Content panel.
When you choose View ➪ Navigation Panels ➪ Content, the Content palette opens in a floating palette as
shown in Figure 1.46. Content features help you reflow tagged PDF files and manipulate the structure of
tagged documents.

FIGURE 1.46

The Content palette opens in a floating palette where the structural content of the open file is reported.

For information on working with the Content palette and tagged PDF documents, see 
Chapter 25.CROSS-REFCROSS-REF
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Destinations
Destinations work similarly to bookmarks, in that specific views are captured and listed in the panel.
Clicking a destination opens the associated page in the Document pane, whereas clicking a bookmark
opens the associated view (page and zoom).

For information on creating destinations and managing them, see Chapter 22.

Fields
The Fields panel enables you to manage form fields on Acrobat PDF forms. You can list all form fields in the
panel and execute menu commands from the pull-down menu and context menu opened from within the
palette.

For information about Acrobat forms, see Part VI.

Info
The Info panel displays the x,y position of the mouse cursor as you move it around the Document pane.
From this panel you can choose to display from among three different units of measure — points, inches,
millimeters, centimeters, and picas. No changes have been made to the Info palette in Acrobat viewers.

For information on working with the Info panel, see Chapter 4.

Layers
If you create documents containing Adobe PDF layers, the Layers palette permits you to toggle layer views
and work with layer properties. In Figure 1.47, the Layers palette is open showing visible and hidden layers.

FIGURE 1.47

The Layers palette enables you to manage layer visibility.

To understand more about working with Adobe PDF layers, see Chapter 24.CROSS-REFCROSS-REF
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Model Tree
The Model Tree palette lets you examine information related to 3D drawings. You can review assets, hide
and show drawing parts, toggle views, review comments, and more on 3D drawings. In Figure 1.48 you can
see the model tree shown for a 3D image.

FIGURE 1.48

The Model Tree palette is designed to work with 3D drawings.

For more information about viewing 3D drawings and Acrobat 3D, see Chapter 2.

Order
You use the Order panel to manage reading order of documents. This panel also relates to document acces-
sibility, like the options available in the Tags panel. The Order panel enables you to add tags to a document,
clear tags, and reorder a page’s contents to change a reading order that might be read aloud by a screen
reader.

For information on working with the Order panel, understanding screen readers, and docu-
ment accessibility, see Chapter 25.

Tags
Tagged PDF files provide more editing capability with PDF documents, and the files can be made accessible
to adaptive devices such as screen readers. For adding, editing, and annotating tags in PDF documents use
the Tags panel. Together with the Content panel options, you have much control over document accessibility.

To understand accessibility and the advantages of creating tagged PDF documents, see 
Chapter 25.CROSS-REFCROSS-REF
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Palette menus
Each of the panels contains its own pull-down menu. When a panel is open in the Navigation pane or in a
floating window, select the Options down-pointing arrow to open a pull-down menu, as shown in Figure
1.49. Menu commands found in panels may or may not be available from the top-level menu bar.
Additionally, some panels, like the Attachments and Comments panels, offer you several pull-down menus.

FIGURE 1.49

Palette Options menus provide menu commands specific to each palette function.

Context menus
Context menus can display different options for palette choices depending on where you open a context
menu. If you move the cursor to an empty area when all text and objects in a palette are deselected and
open a context menu, the menu options may be different than when you select text or an object in a palette.
However, this is not always the case, because a few palettes provide you with the same options regardless of
whether something is selected or not. In Figure 1.50 a context menu is opened within the Bookmarks
panel. In this case you need to open the menu on a bookmark name. If you attempt to open a context menu
in an empty area in the pane, no menu opens.

In Figure 1.51, a page in the Pages pane is selected and a context menu is opened on the page, as shown on
the left side of the figure. On the right, a context menu is opened in an empty area in the pages pane. This
figure illustrates the different menu options some panels have when selecting an object versus an open area
in the pane. 
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FIGURE 1.50

A context menu opened on a bookmark.

FIGURE 1.51

When a page is selected in the Pages palette and a context menu is opened, more menu choices are available than
when no page is selected.

Accessing Help
You can see the number of different commands and tools available in Acrobat are extraordinary — and you
haven’t yet looked at all the submenu options or different preference options accessed from the top-level
menu bar. With all these features available to you, your initial Acrobat sessions can sometimes be over-
whelming. Fortunately, the great engineers and program designers at Adobe Systems thought about you and
they decided to provide some help.

Help with learning more about Acrobat comes in several forms and you can choose from several help meth-
ods to find the one that works well in your workflow. This section covers different options for getting help
in an Acrobat session.
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Getting Started in Acrobat
When you first launch Acrobat, the Getting Started window opens, as shown in Figure 1.52. This window
provides a number of different help items that ease you into the world of Acrobat and PDF.

FIGURE 1.52

When you first launch Acrobat 8, the Getting Started window opens.

Click any one of the eight buttons in the Getting Started window and another pane respective to your selec-
tion opens where help information is provided.

For more detail on the options in the Getting Started Window, see Chapter 4.

How To pane
The How To panel appears in the Navigation pane. Click the icon with a question mark and the How To
pane opens. The topics in the How To pane are similar to those in the welcome screen. Click a topic listed
in the pane and a second screen opens in the pane, providing another list of topics. Click on a topic and
help information is provided in the pane, as shown in Figure 1.53.
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FIGURE 1.53

Click different topics in the How To pane in the Navigation pane to explore help information.

Acrobat help
The How To window contains a select group of common Acrobat features about which you can find help
within the listed topics on the Homepage. However, Acrobat is a monster program with many features and
listing all the methods for working in the program is not the purpose of the How To help pane. To browse
through a comprehensive help guide you need to access a different document. The comprehensive help
guide contains more than 800 pages covering just about everything you want to know about Acrobat. There
are, in essence, two flavors of the Acrobat Help guide. You can access the Complete Acrobat 8.0 Help docu-
ment by selecting Help ➪ Complete Adobe Acrobat 8.0 Professional (or Standard) Help or you can open
the Acrohelp.pdf file in Acrobat. These two documents are different in that the Complete Acrobat Help doc-
ument is viewed in a separate executable application called the Adobe Help Viewer. The Acrohelp.pdf file is
a standard PDF document contained in the Acrobat folder. Depending on which one you open, you have
some different methods for viewing and navigation.

Complete Acrobat 8.0 Help
You open the Adobe Help Viewer window by selecting Help ➪ Complete Adobe Acrobat 8.0 Professional
(or Standard) Help. The Adobe Help Viewer contains three tabs appear in the top of the window as shown
in Figure 1.54. Click the Contents tab to show bookmarks, Index to see an alphabetical list of indexed top-
ics, and Search to search for keywords.

Contents tab
By default the Adobe Help Viewer document opens with the Contents tab exposed as shown in Figure 1.54.
In the Navigation pane you’ll find a table of contents for the document shown in a very similar manner to
the way bookmarks are listed in a PDF document. Click one of the bookmark topics listed in the Contents
tab to see the respective bookmarked page in the Topic pane.
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Search tab
You can use the Search tab to find any word(s) in the help document. Click the Search tab and the
Navigation pane changes to display a field box where you type your search criteria. Type one or more words
in the field box and click Search. The results then appear in the Search tab. All text appearing in red is
linked to the page that opens in the Topic pane.

FIGURE 1.54

The Adobe Help Viewer opens as a floating window with three tabs — Contents, for listing bookmarks; Index, for an
alphabetical topic list; and Search, for keyword searches.

Index tab
The Index tab is an alpha index of topics. Click the text to open pages linked to the topics.

Navigating topics
The arrows at the top of the Navigation pane enable you to move forward and back to the pages you view
during your search. The review history remains in memory until you close the document. If you close the
help file, the review history is flushed from memory and you need to begin again to find information on the
same topics. On the right side of the Topic pane is a scroll bar. Use the arrow keys and elevator bar to view
documents as you do in any application document.

Printing topics
The Print tool located at the top of the Navigation pane opens the Print dialog box. In the Print dialog box
you can choose to print a single page or a page range. 
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Adobe LiveCycle Designer
Adobe LiveCycle Designer is a separate executable program available to Acrobat Professional users on
Windows only. Designer is used for creating dynamic XML forms. Designer also has a help document to
assist you in learning the program. To access the Help file, select Help ➪ Adobe LiveCycle Designer Help or
press the F1 key. The help document shown in Figure 1.55 opens.

Under the help menu you find other help options for accessing the Designer How To window and opening
a scripting notation in the Adobe LiveCycle Designer help document with a link to a Web page on Adobe’s
Web site where more information about Adobe LiveCycle Designer can be found. In addition to menu com-
mands under the Help menu you have sample files contained in the Adobe LiveCycle Designer 8.0 folder.
Browse the folder contents to learn more about creating forms in LiveCycle Designer.

FIGURE 1.55

Press the F1 key in Adobe Designer to open the help document.

More help
In addition to the help file that covers working in Acrobat, some other help PDF files are located in the
Help folder inside your Acrobat folder. These help documents are specific to certain tasks, such as pdfmark
and Distiller parameters. To view the help documents, open your Acrobat folder and open the Help\ENU
folder. The files are PDF documents and can be opened in any viewer. 

Online help is available to you as well from Adobe Systems. If you choose Help ➪ Online Support and
select one of the submenu items, your default Web browser launches and the Adobe Acrobat support page
opens from Adobe’s Web site. This Web page links to pages that are continually updated so be certain to
make frequent visits to the Acrobat Online help Web pages.
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When accessing Adobe’s Online Support, your Web browser opens in the foreground while
Acrobat Professional remains open in the background. When you finish viewing Web pages

and quit your Web browser, the Acrobat window returns to view.

Acrobat User Community
Adobe Systems sponsors a user group forum and supports the development of user groups internationally.
Some of the world’s leading experts on Acrobat participate through providing tips, articles, and hosting blog
sessions. You can find some of the most up-to-date information at www.acrobatusers.com. Open the
Adobe Acrobat User Community Web page and the opening page appears as shown in Figure 1.56. Here
you’ll find an easy to use Web site filled with many tips and solutions.

If you’re interested in learning more about Acrobat, you may find a user group close to your home. If not,
you can become one of the many people who start a local user group. You’ll find great support from Adobe
if you want to start a group. To learn more about the location of user groups and how to go about starting
one, search the Adobe Acrobat User Community Web site.

FIGURE 1.56

Log on to www.acrobatusers.com to find up-to-date information on Acrobat and PDF.

NOTENOTE

49

Getting to Know Adobe Acrobat 1

06_050514 ch01.qxp  12/29/06  11:13 PM  Page 49



Understanding Preferences
Preferences enable you to customize your work sessions in Acrobat. You can access a Preferences dialog box
from within any Acrobat viewer and from within a Web browser when viewing PDFs as inline views. A huge
number of preferences exist that all relate to specific tool groups or task categories, and it would not make
as much sense to cover them here in the opening chapter as it would within chapters related to using tools
and methods influenced by preference choices. 

Some general things you should know about preferences is that they are contained in a dialog box as shown
in Figure 1.57. You make a topic selection in the list on the left side of the dialog box and the related prefer-
ences are shown to the right side of the list. You make choices for preferences by selecting check boxes or
making menu selections from pull-down menus. When you complete making your preference choices, click
OK at the bottom of the dialog box.

Almost all the preferences you change in the Preferences dialog box are dynamic, which means you don’t
need to quit Acrobat and relaunch the program for a preference choice to take effect. Preferences remain in
effect until you change them again. If you quit Acrobat and relaunch the program, the preferences you last
made are honored by Acrobat. However, if for some reason the program crashes and you don’t shut it down
properly, any new preference changes will not be recognized when the program is launched again.

FIGURE 1.57

Press Ctrl/Ô+K to open the Preferences dialog box. Click a category on the left and the choices are reflected to the
left of the categories list.

If you find some operation in Acrobat not working as you think it should, first take a look at the Preferences
dialog box. In many cases you’ll find a check box or menu command not enabled to permit you to perform
a task. As you become familiar with specific tool groups and menu commands, make a habit of routinely
visiting the Preferences dialog box so you understand all the toggles and switches that affect tool and view-
ing behavior.
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Summary
This chapter offers you a general introduction for working in both Acrobat Standard and Acrobat
Professional and helps you understand the environment, the user interface, and some of the many new fea-
tures added to the commercial Acrobat products. At the very least, you should know how to go about find-
ing help when you first start working in the program. Some of the more important points discussed in this
chapter include the following:

n Adobe Acrobat is a multifaceted program designed to provide solutions for many different busi-
ness professionals. Several types of Acrobat viewers exist, ranging in features to suit different user
needs. The most sophisticated of the three viewers is Acrobat Professional, now in version 8.
Acrobat Standard offers fewer tools and menu commands than Acrobat Professional and is now
available only on Windows.

n PDF, short for Portable Document Format, was developed by Adobe Systems and was designed to
exchange documents between computers and across computer platforms while maintaining file
integrity.

n The PDF language format has changed version numbers along with the Acrobat viewers. The cur-
rent PDF version is 1.7.

n Tasks are performed through the use of menus, tools, and palettes that can be accessed through
mouse selections and keyboard shortcuts.

n The extensive list of tools appears in an abbreviated form when you open Acrobat and view the
default toolbars. You can open additional toolbars from menu commands or the new More Tools
window. You can dock toolbars in the Toolbar Well or float them around the Acrobat window.

n Palettes are similar to toolbars in that they can be docked and undocked from a well called the
Navigation pane. Palettes contain pull-down menus, and some palettes contain tools.

n You can customize the Acrobat workplace to suit your work style through the use of different
preference choices. When preferences, palettes, and toolbars are changed from their default views,
the new views are saved when you quit your Acrobat session. They remain unchanged until you
change them again or reset them to defaults.

n Acrobat Professional provides you extensive assistance through the use of help documents. You
can gain immediate help on selected topics through choices in the How To pane or by expanding
your list of categories to seek help in the Complete Acrobat 8.0 Help window. In addition to help
documents, Adobe sponsors the development of local Adobe Acrobat user groups worldwide. To
learn more visit www.acrobatusers.com.

n Preferences are settings that apply globally to Acrobat and influence the behavior of tools and
menu commands.

51

Getting to Know Adobe Acrobat 1

06_050514 ch01.qxp  12/29/06  11:13 PM  Page 51



06_050514 ch01.qxp  12/29/06  11:13 PM  Page 52



In Chapter 1 you got a feel for some of the tools and menu commands pro-
vided in Acrobat Standard and Acrobat Professional. If you’re a PDF author
and you use Acrobat Standard or Professional, knowing the capabilities of

one viewer versus another is important for both job efficiency and productivity,
as well as usefulness to the end user. You may want to add multimedia to a PDF
document. Therefore, you need to know what authoring tool is needed to import
video and sound. You may be sending out a document for review and want to
solicit comments. Therefore, you need to know what viewer a user needs to send
comments back to you.

At times you may find that neither Acrobat Standard nor Professional can help
you do some editing tasks needed in your workflow. Fortunately, you have
options for acquiring Acrobat plug-ins developed by third-party manufacturers
that add much more functionality to the Acrobat tools and menu commands.

Many of the chapters ahead give you an idea of the distinctions between Acrobat
Standard and Acrobat Professional and the tools accessible from one viewer ver-
sus the other. This chapter introduces you to the Acrobat viewers, points out
some differences among them, and shows you how to use Acrobat plug-ins when
you need more features than the viewers provide.

Viewer Distinctions
Adobe Reader, Acrobat Standard (Windows only in version 8), Acrobat
Professional, Acrobat 3D, and Acrobat Elements are designed to serve different
users with different purposes. It should be obvious to you that Adobe Reader, as
a free download from Adobe’s Web site, is much more limited in features and
performance than the products you purchase. It should also be obvious that
because of the low cost of Acrobat Elements, it is much more limited in features
than Acrobat Standard, Acrobat Professional, and Acrobat 3D.
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For a general overview, take a look at the following descriptions of the Acrobat products.

Adobe Reader
Adobe Reader is available for download from Adobe’s Web site free of charge. The Adobe Reader software is
distributed for the purpose of viewing, printing, and searching, on PDF files created by users of Acrobat
Elements, Acrobat Standard, Acrobat Professional or Acrobat 3D. Additionally, Adobe Reader is used for fill-
ing in forms on PDFs created with Acrobat Professional. The major features of Adobe Reader include:

n Viewing and printing. These features are common across all Acrobat viewers. You can view, navi-
gate, and print PDF documents with Adobe Reader.

n Forms completion and submission. Adobe Reader enables you to complete forms but not save
the form field data unless the forms carry special usage rights for Adobe Reader users. Forms are
submitted through the use of buttons created on forms for e-mailing or submitting data to Web
servers.

Forms and digital signatures can be saved from Adobe Reader if a PDF has been enabled with
special rights. New in Acrobat is a feature to enable PDFs to save form data filled in with

Adobe Reader. By default form field data cannot be saved. Only Acrobat Professional and Acrobat 3D pro-
vide this feature to enable PDFs with usage rights.

For more information on enabling PDFs with usage rights, see Chapter 19.

n Comment and Review. PDFs can be enabled with usage rights for commenting and review in
Acrobat Professional and Acrobat 3D only. Once enabled, Reader users can participate in a review
workflow and save PDFs locally with comments and markups.

n Reader Extensions Server. If an organization uses the Adobe LiveCycle Reader Extensions Server
product available from Adobe Systems to enhance PDF files, Adobe Reader users can digitally sign
documents and save form data.

A distinction exists between enabling PDFs with usage rights from within Acrobat
Professional/Acrobat 3D and using the Adobe Reader Extensions Server. Licensing restrictions do
apply when enabling documents and you should be aware of these restrictions. See Chapter 19,
for all you need to know about enabling PDFs and licensing restrictions.

In addition to the preceding, Adobe Reader provides support for eBook services and searching PDF docu-
ments, as well as extended support for working with accessible documents.

For more information on using tools in Adobe Reader, see Chapter 4.

Acrobat Elements
Acrobat Elements is available for site license purchasing of 100 or more copies on Windows only. The unit
costs are very aggressive and are lowered with higher volume purchases. This product is intended to offer
large companies and enterprises a means for employees to create PDF files. The primary features of Acrobat
Elements include:

n Viewing and printing. For viewing PDFs, the Adobe Reader software is used as the viewer.
Elements in and of itself is not an Acrobat viewer.

n PDF creation. The PDF creation capability available from Elements is limited to creating PDF
documents from Microsoft Office products or printing files to the Adobe PDF printer. 

CROSS-REFCROSS-REF
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Acrobat Standard versus Acrobat Professional
Acrobat Standard is available only on Windows in version 8 of Acrobat. The Macintosh version has been
discontinued. Adobe Systems is a company that tries hard to respond to user needs, but there are limita-
tions. If a product does not support the development costs, then it is likely to be discontinued. This is the
case with Acrobat Standard on the Macintosh. Many users of Acrobat on the Mac acquire Acrobat
Professional in a bundled purchase with the Adobe Creative Suite. Independent sales of Acrobat Standard
were minimal on the Mac during the Acrobat 7 life cycle. Therefore, Adobe could not justify the develop-
ment costs for continuing the product. On Windows, sales of Acrobat Standard were much greater, and
therefore you see Acrobat Standard still available.

Acrobat Standard is the lightweight of the authoring programs. However, Acrobat Standard still offers many
tools for PDF creation and authoring. Without going into every tool that differs between Acrobat Standard
and Acrobat Professional, the major differences include the following limitations:

n Form field authoring. No form tools or form field authoring is available with Acrobat Standard.
JavaScripts on form fields cannot be created in Acrobat Standard. However, if a JavaScript is con-
tained in an area accessible to Acrobat Standard (such as Bookmark Properties or Link Properties),
the JavaScript can be edited. You can also write JavaScripts on Page Actions in Acrobat Standard.

For information on writing JavaScripts, see Chapter 36.

n Professional printing. Acrobat Standard does not provide options for soft proofing color, pre-
flighting jobs, or commercial printing using such features as color separations, frequency control,
transparency flattening, and so on. All these print controls are contained only in Acrobat
Professional.

For information on pre-flighting, soft proofing color, and commercial printing, see Chapter 32.

n Adding Adobe Reader usage rights. You can add usage rights enabling Adobe Reader users to
add comments, extract file attachments to PDF documents, and in Acrobat 8 add usage rights for
saving form field data and digital signatures in Acrobat Professional. Acrobat Standard does not
support adding usage rights to PDF files for Reader users.

For information on adding usage rights for Adobe Reader users, see Chapter 19.

n Redaction. The new tools for redacting documents are not available to Acrobat Standard users.

For information on using the Redaction tools and redacting documents, see Chapter 14.

n Batch processing. Acrobat Standard does not support batch processing and running batch 
commands.

For information on creating batch sequences, see Chapter 18.

n Creating index files. Acrobat Catalog is not part of Acrobat Standard. You can create index files
only with Acrobat Professional through a menu command that launches Acrobat Catalog.

For information on creating index files, see Chapter 6.CROSS-REFCROSS-REF
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n Creating PDFs. Acrobat Standard offers support for an impressive range of file types that can be
converted to PDF. However, Acrobat Standard doesn’t support creating PDFs from certain file
types such as AutoCAD, Microsoft Visio, and Microsoft Project. Acrobat Standard does use
Acrobat Distiller, but the Acrobat Standard Distiller does not support PDF/X, PDF/E, and PDF/A
compliance.

For information on using Acrobat Distiller, see Chapter 8. For information on PDF/A and
PDF/X, see Chapters 10 and 32.

n Engineering tools. Acrobat Standard does not support some features used by engineers and tech-
nical illustrators, such as merging and flattening layers.

For information on using the measuring tools and working with layers, see Chapter 24.

The preceding items are some of the major differences between these two commercial viewers. You will dis-
cover subtle differences as you work with the programs. For example, Acrobat Standard doesn’t support
comparing documents, migrating comments, Bates numbering, show and snap to grids, convert .dwg and
.indd files, does not contain the PDF Optimizer for repurposing files, and so on.

If your mission is to recommend the product for purchase or make the decision for your own use, be aware
of the four primary distinctions between the products: Acrobat Standard does not support forms authoring,
professional printing, engineering tools, or adding Adobe Reader usage rights for review and comment and
forms data saving and digital signatures. If your work is in one of these areas, you need to purchase Acrobat
Professional.

Acrobat 3D
Acrobat 3D is a commercial Acrobat product with all the features of Acrobat Professional. Its main focus is
on the manufacturing segment and aimed at Engineering Design and Technical Publication workflows.
Acrobat 3D additionally adds support for the Acrobat 3D Toolkit, 3D Capture for UNIX, and a conversion
framework for converting and placing major CAD file formats into PDF files. This is a separate Acrobat
product you can purchase for use with 3D drawings created in almost all major CAD formats. Among some
of the features you find with Acrobat 3D are the following:

n File conversion. Acrobat 3D supports 3D drawing translations from all major 3D drawing pro-
grams including AutoCAD. These drawings can be imported directly into Acrobat 3D where com-
ments, reviews, and markups can be applied and then shared with anyone using the free Adobe
Reader.

n Capture 3D files. Acrobat 3D includes Acrobat 3D Capture so that you can convert any 3D
drawing to PDF for use in Acrobat 3D.

n Optimize, enhance, and animate. Features in Acrobat 3D enable you to optimize drawings for
faster display. You can add multiple views and materials and textures, multiple types of lighting
and create animations such as exploded views, and more.

n File compression. 3D drawing files can be optimized for smaller file sizes.

n 3D drawing creation. You can create simple 3D drawings directly in Acrobat 3D.

n Photorealistic rendering. You can render photorealistic images and create 2D raster and vector
images.

There’s much more to Acrobat 3D. If you’re an engineer or technical artist working with CAD applications,
you might want to check out some of the benefits of working with Acrobat 3D. This book does not cover
Acrobat 3D features in the chapters ahead. To learn more about Acrobat 3D, take a look at the Acrobat 3D
Corner on the Adobe Acrobat User Community Web site at www.acrobatusers.com/go/3D.

CROSS-REFCROSS-REF
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Using Plug-ins
All Acrobat viewers support a plug-in architecture. Plug-ins are installed during your Acrobat installation
and loaded when you launch Acrobat. Many of the features you find when exercising commands and using
tools are made possible by the use of plug-ins. To view the current plug-ins loaded with the viewer you use,
choose Help ➪ About Adobe Plug-ins. The About Adobe Plug-Ins dialog box opens as shown in Figure 2.1.

FIGURE 2.1

The About Adobe Plug-Ins dialog box lists all the plug-ins accessible to your viewer.

The list in the left side of the dialog box lists the names of the installed plug-ins. Click a name to see a
description for the plug-in, including whether the plug-in is certified, the version number, creation date,
text description, and dependencies. To examine different plug-ins, select them in the left pane and view the
description on the right side of the dialog box.

Acrobat plug-ins are developed by Adobe Systems and third-party developers. All plug-ins developed by
Adobe Systems are certified plug-ins. No third-party plug-ins are certified. Some features in Acrobat require
that only certified plug-ins be loaded before the feature is enabled. Working with eBooks is one example
where only certified plug-ins can be used. 

Any time a document has Adobe DRM (Digital Rights Management) protection such as eBooks
and/or documents protected with the Adobe Policy Server, the viewer is launched in certified

plug-in mode. This mode loads only Adobe plug-ins and disables all third party plug-ins.

In order to instruct your Acrobat viewer to open with only certified plug-ins, open the Preferences dialog
box by choosing Edit ➪ Preferences. Select General in the left pane and select the Use only certified plug-
ins check box, as shown in Figure 2.2. When you quit your Acrobat viewer and relaunch the program, only
certified plug-ins will load.

NOTENOTE
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FIGURE 2.2

Select Use only certified plug-ins to open Acrobat to allow only certified plug-ins to load.

Plug-ins developed by third-party developers can also be loaded. The list of available resources for adding to
Acrobat functionality in the form of add-ons and plug-ins is almost limitless. As you review all the chapters in
this book and find that something you want to accomplish in your workflow is not covered, look for a plug-in
developed by a third-party developer. Chances are that you can find a product well suited to do the job.

Plug-ins for Acrobat are far too numerous to mention in this book. For a single source where you can view a
list of plug-ins, download demonstration copies, and make purchases, visit the Planet PDF store at
www.pdfstore.com , the Adobe Store at www.adobe.com and click on the Store link, or The
PowerXChange at: www.thepowerxchange.com. On several Web sites you’ll find product descriptions
and workflow solutions for almost any third-party product designed to work with Acrobat. When you visit
one of the Web sites and review the products, be certain the product you purchase is upgraded to work
with Acrobat 8.0 and the viewer you use. All products are listed with links to the manufacturer’s Web sites,
so you can find information on product descriptions, version numbers, and compatibility issues.

Installing plug-ins
Most plug-ins you acquire from third-party manufacturers are accompanied by an installer program.
Installing plug-ins is easy. Open the folder for a plug-in you download from a Web site and double-click on
the installer icon. The installer routine finds the plug-ins folder inside your Acrobat folder and the plug-in is
loaded when you launch Acrobat.

If a plug-in is not accompanied by an installer program, you need to manually add the plug-in to your
Acrobat plug-ins folder. On Windows, open the Program Files\Adobe\Acrobat 8.0\Acrobat\plug_ins folder.
Copy the plug-in you want to install to this folder.

On the Macintosh, open your Applications folder. Open the Acrobat 8 Professional (or Standard) folder
from within the Applications folder. Press and hold the Control key and click the program icon (Adobe
Acrobat 8 Professional or Adobe Acrobat 8 Standard) to open a context menu, as shown in Figure 2.3. From
the menu items, select Show Package Contents.
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FIGURE 2.3

Open the Package Contents on the Macintosh to gain access to the Plug-ins folder.

When you open the Package Contents, the Contents folder appears in a single window. Double-click the
folder to open it. Several folders appear within the Contents folder, one of which is named Plug-ins. Open
this folder and copy your plug-in to it.

Uninstalling plug-ins
If your plug-in is not accompanied by an uninstaller program, you need to either disable the plug-in or
physically remove it from the Acrobat plug-ins folder. A temporary solution is to disable third-party plug-
ins by opening the Preferences dialog box, clicking on Startup, and selecting the check box for Use only
certified plug-ins, as shown earlier in Figure 2.2.

To permanently remove a plug-in, open the plug-ins folder as described in the previous section, “Installing
plug-ins,” and drag the plug-in out of the Acrobat plug-ins folder.

Some plug-ins are installed in their own folder. To remove a plug-in, drag the folder where the
plug-in is installed out of the Acrobat plug-ins folder. Be certain not to remove the Acrobat

plug-ins folder from within the Acrobat folder. Doing so disables all tools and menu commands using plug-ins.

Resolving plug-in conflicts
At times you may find a plug-in conflict among several third-party products or a plug-in that may have a
bug. If your Acrobat functionality is impaired and you can’t launch the program, hold down the Shift key
while double-clicking the program icon to launch your viewer. All plug-ins are disabled when you use the
modifier key. Open the Preferences dialog box again and select the Use only certified plug-ins check box.
Quit and relaunch the program, and the offending plug-in is eliminated during startup.

CAUTION CAUTION
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If a plug-in is creating a problem, you may need to use a process of elimination to figure out which one it is
by opening your plug-ins folder and removing all plug-ins. Then add several plug-ins at a time back to the
plug-ins folder and launch your viewer. Keep adding plug-ins back to the plug-ins folder until you discover
the plug-in that produces the error.

Working with plug-ins
There are many different plug-ins that provide you more features when working with Adobe Acrobat and
Adobe Reader than can be covered in this book. To pick one out among the many is a hard choice. For your
own workflow, visit the Planet PDF Store, Adobe Store, the PowerXChange, or the Acrobat User
Community and explore various plug-ins available for download. Try to find a plug-in that offers at least a
demo trial period and download it.

Almost all plug-ins come with a ReadMe file or user manual. Before installing a plug-in, be certain to review
the installation recommendations by the developer. Install the plug-in and give it a try.

For a trial in using a plug-in, see Chapter 36 where using a third-party plug-in is discussed in more detail.
Windows users can follow steps to install and use a plug-in by installing the AcroButtons and AcroDialogs
plug-ins from the book’s CD-ROM.

See the book’s CD-ROM for plug-in installers for AcroButtons and AcroDialogs developed by
WindJack Solutions. These installers are for use on Windows only.

Summary
n The four Acrobat viewers include Adobe Reader, Acrobat Standard, Acrobat Professional, and

Acrobat 3D. The tools that can create Adobe PDFs include Acrobat Elements, Acrobat Standard,
Acrobat Professional, and Acrobat 3D.

n Adobe Reader is a free download from Adobe’s Web site. All other products require purchase.
Acrobat Elements is available only in site license quantities of 100 or more.

n Acrobat Standard offers fewer features than Acrobat Professional and is available in version 8 on
Windows only. The primary limitations with Acrobat Standard are no support for Forms creation,
commercial printing tools, engineering tools, or creating PDFs with Adobe Reader usage rights.
These features are only available in Acrobat Professional or Acrobat 3D.

n Acrobat plug-ins are additions to Acrobat that offer features and tools for adding more functional-
ity to Acrobat viewers. Plug-ins are installed with Acrobat from sources developed by Adobe
Systems.

n Plug-ins are available from third-party software manufacturers. A complete list of plug-ins and
demonstration products is available at the Planet PDF Store, the Adobe Store, and The
PowerXChange.

ON the CD-ROMON the CD-ROM
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In Chapter 1, I talked about getting help in Adobe Acrobat using many differ-
ent help menu commands and I discussed a little bit about using the new
Getting Started with Adobe Acrobat welcome window. There’s much more to

this welcome window, as well as different ways to access it, than I covered in
Chapter 1. Therefore, a separate chapter detailing the specifics of the welcome
and help options seems appropriate.

In this chapter, I talk about some of the links and options you have using the
Getting Started with Adobe Acrobat welcome window when you start up Acrobat
and when you begin to work on some different editing tasks.

Getting Started Window
The window you see when you launch Acrobat viewers is the Getting Started win-
dow. Depending on the viewer you launch you’ll see Getting Started with Adobe
Acrobat 8 Professional (or Getting Started with Adobe Acrobat 8 Standard — Windows,
or Beyond Adobe Reader). When you first launch Acrobat 8 Professional you see
the Getting Started window, as shown in Figure 3.1.

The same welcome window with some different options appears in all Acrobat
viewers in Acrobat version 8. Figure 3.1 shows the screen opened in Acrobat
Professional.
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FIGURE 3.1

The Getting Started with Adobe Acrobat 8 Professional window opens when you first launch Acrobat 8 Professional.

Navigating the Getting Started Window
When you first start using Acrobat 8, you’ll want to take a look at the options available to you in the Getting
Started window to access some help information. At some point, though, you’ll want to bypass the screen
when engaging in an Acrobat editing session. To stop the screen from opening on startup, check the box in
the upper right corner where you see Do not show at startup. The next time you launch Acrobat, the
Getting Started window won’t open.

If at any time you want to reopen the window, select Help ➪ Getting Started with Adobe Acrobat. The
Getting Started window always opens on top of the Acrobat Document pane.

The Getting Started window contains eight task buttons that are links to other panes in the Getting Started
window. When you click one of the buttons the second pane opens and displays information about the
respective feature available in Acrobat.

On the second pane for any one of the eight individual task topics you find different icons and buttons that
include:

n Task action. Click this button or the text adjacent to the button and Acrobat launches a
dialog box or menu command to perform an action.

n Task description. Adjacent to this icon you find a short description explaining certain
features available with the respective task.
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n Task help. Click the icon or the text description adjacent to the icon and the Adobe Help
Viewer opens displaying help information related to the respective task.

n Home. Click the Home button and you return to the first pane in the welcome window.

Using the Tasks Buttons
The eight tasks panes describe various options you have with the related topic and include buttons you can
click to find help on the related task and buttons to get you started working with a given feature. These
eight features include:

n Create PDF. The Create PDF task provides you with help information as well as links directly to
dialog boxes used for PDF creation. A description is provided in the central pane, as shown in
Figure 3.2.

FIGURE 3.2

The Create PDF task pane provides help information and links to dialog boxes.

Clicking Learn How to Create PDFs from Other Applications opens the Adobe Help Viewer where
creating PDFs using the Adobe PDFMaker is explained. Clicking Learn How to Create PDF with
the Adobe PDF Printer links you to the Adobe Help Viewer where creating PDFs by printing to
files is explained. Clicking one of the task action buttons opens menu commands found in the
Create PDF task button pull-down menu.

For more information on creating PDFs from other applications, see Chapters 8 and 9. For
information on creating PDFs with the Adobe PDF Printer, see Chapters 7 and 10.CROSS-REFCROSS-REF
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n Combine Files. The new Combine Files feature is a great new addition to Acrobat 8. In the cen-
ter of the Combine Files task pane shown in Figure 3.3 you see a list of descriptions for how com-
bining files can be helpful for people working with legal documents, CAD drawings, Project
Binders, and Sales Proposals. This is only an abbreviated list of descriptions for why you may
want to use the Combine Files feature.

FIGURE 3.3

The Combine Files pane provides help information and links to dialog boxes related to
combining files and creating PDF Packages.

The Combine Files task links open the Combine multiple files into one PDF file dialog box. At the
bottom of the task pane, you see a link to help information on creating PDF Packages.

For more information on combining files and creating PDF Packages, see Chapter 12.CROSS-REFCROSS-REF
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n Export. The Export tasks pane describes some file formats that you can export from Acrobat and
several links to help information related to file exporting. As you can see in Figure 3.4, all the
links in this task pane relate to providing help information. (When you see the text link begin
with Learn how to . . ., the link is made to the Adobe Help Viewer document.)

For more information related to exporting PDF documents to other formats, see Chapter 11.

n Start Meeting. Start Meeting tasks shown in Figure 3.5 are related to Acrobat Connect sessions.
You find help information related to Acrobat Connect and a link to the Welcome to Start Meeting
dialog box where you can sign up for a free Acrobat Connect trial account.

For more information on Acrobat Connect and setting up a trial account, see Chapter 29.

FIGURE 3.4

The Export task pane provides help information related to exporting PDFs to other file formats.

CROSS-REFCROSS-REF

CROSS-REFCROSS-REF

65

Getting Started in Adobe Acrobat 3

08_050514 ch03.qxp  12/29/06  11:14 PM  Page 65



FIGURE 3.5

Start Meeting displays information related to Acrobat Connect.

n Secure. The Secure task pane contains information on securing PDF files. (See Figure 3.6.)
Information is provided in the center of the pane for the many options Adobe offers you with PDF
security and some links to help information that describes how to secure PDF files. Also, a link is
made to the Create security envelope dialog box.

For more information related to securing PDF files, see Chapter 26.

n Sign. The Sign tasks pane shown in Figure 3.7 provides you with information links to help files
related to digital IDs and digitally signing documents.

CROSS-REFCROSS-REF
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FIGURE 3.6

The Secure task pane provides information for adding security to PDF documents.

FIGURE 3.7

The Sign pane provides information related to digital signatures.
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For more information related to digital IDs and digitally signing PDFs, see Chapter 26.

n Forms. A number of different links appear in the Forms task pane to pages in the Adobe Help
Viewer and to dialog boxes for creating and editing forms. In Figure 3.8, you can see options for
Browsing a template library (Windows), Convert an existing document, Scan a paper form, Create
a new form, track forms, Distribute forms, and Compile data. All these links open dialog boxes or
launch another program. On Windows, links to Create a new form and Browse the Template
library launch Adobe LiveCycle Designer. On the Mac, you won’t find the Browse the template
library link, because Designer isn’t supported. Other links are made to help files that provide
more information on creating and editing forms.

For information on working in Adobe Designer, see Chapter 33. For more information related
to creating and editing PDF forms, see Chapter 34. For more information on collecting and

compiling data, see Chapter 35.

n Review and Comment. The last of the tasks panes is the Review and Comment pane shown in
Figure 3.9. Here you find links to help information related to commenting and review sessions.
The Start a shared review features action button opens a wizard that walks you through steps to
create a review session. The task actions buttons at the bottom of the E-mail and Shared columns
open wizards that walk you through steps for starting n e-mail-based review or a shared review.

For more information related to commenting and markups, see Chapter 20. For more informa-
tion on shared reviews, see Chapter 21.

FIGURE 3.8

The Forms task pane provides information for help with creating and editing PDF forms and
links that open dialog boxes and Adobe Designer (Windows only).
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FIGURE 3.9

The Review & Comment task pane provides information for help with commenting and
review sessions and links to a dialog box and a wizard to start and track reviews.

Opening the Tasks Descriptions from Tasks
Buttons
If you look at the Tasks toolbar at the top of the Acrobat window you’ll see the same tasks you find in the
Getting Started window — that is, all but the last task button used for Send for Review. The first eight task
buttons in the Tasks toolbar each have a menu command at the bottom of the task button drop-down menu
that opens the Getting Started with Adobe Acrobat 8 Professional window and opens the pane respective to
the task from which you select the menu command. In Figure 3.10, the menu command appears at the bot-
tom of the Combine Files task button. As you can see, the menu command appears as Getting Started
Combining Files. When you select this command, the Getting Started with Adobe Acrobat 8 Professional
window opens and the Combine Files task pane is placed in view. Respectively, all the other task buttons
menu commands, with the exception of the Send for Review task button, launch the Getting Started with
Adobe Acrobat 8 window and open panes according to the task button menu item you select.
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FIGURE 3.10

Task buttons contain menu items that open the Getting Started with Adobe Acrobat 8 window.

Summary
n The Getting Started with Adobe Acrobat welcome window appears in all Acrobat 8 viewers.

n The welcome window provides help information related to many different Acrobat features.

n The welcome window contains links to dialog boxes that support working within a particular 
feature.

n The Forms feature pane has a few links that open Adobe Designer on Windows.

n All the task buttons in the Tasks toolbar with the exception of the Send for Review task button
contain menu commands to open the welcome window and the feature related to the task button
menu item.

70

Welcome to Adobe AcrobatPart I

08_050514 ch03.qxp  12/29/06  11:14 PM  Page 70



As a PDF author you need to be aware of the capabilities and the limita-
tions of the Adobe Reader software. In some situations you can distribute
PDF documents to users of the free Adobe Reader software for active par-

ticipation in your workflow without all your clients and colleagues needing to
purchase the full version of Acrobat Standard or Acrobat Professional. In other
situations where the Adobe Reader software does not contain tools or commands
to properly edit a file for a given workflow, you may need to recommend to oth-
ers which commercial viewer they need to purchase. Regardless of where you are
with PDF creation and editing, at one time or another you’ll be called upon to
explain some of the differences between the viewers.

Adobe Reader has matured as a product and the newest release offers users 
much more functionality than any previous version. Features that have long
been requested by users such as being able to save form data and add digital
signatures are now available in Adobe Reader 8. However, the features are 
document-specific and require at least one person in a workflow attempting
to use these new tools to author a file in Acrobat 8 Professional. 

This chapter covers most of what you need to know about Adobe Reader as both
a user and as a PDF author preparing documents for Reader users.

Welcome to Adobe Reader
The first change you notice when launching Adobe Reader 8 is the welcome
screen. The Beyond Adobe Reader welcome screen shown in Figure 4.1 opens
when you first launch the program. Each time you launch Reader the same
screen opens unless you check the box “Do not show at start up.” If you dismiss
the screen by checking the box for all subsequent launches of Reader, you can
bring the screen back any time by selecting Help ➪ Beyond Adobe Reader.
Alternately, you can also bring the Beyond Adobe Reader screen back by opening
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